Administration

Contents

Navigating in Administration ............................................. 3
Common Administrative Tasks ........................................... 4
Setting Up Programs in The Financial Edge .......................... 4
Viewing System Statistics ................................................ 4
Posting from The Financial Edge Subsidiary Ledgers to General Ledger .... 5
Importing Records ...................................................... 9
Globally Changing Records ............................................ 9
Searching for Duplicate Records ...................................... 10
Accounting Queue ..................................................... 11
Security Settings ....................................................... 11
Validating Your Database .............................................. 12
Creating Consolidation Export Files ................................. 13
Electronic Signatures .................................................. 13
General Ledger Administration ..................................... 16
Posting in General Ledger ............................................ 16
Fiscal Year-End Procedures ........................................... 23
Beginning Balances .................................................... 27
Updating Fund Transaction Requirements ............................ 34
Accounts Payable Administration .................................... 36
Purging Vendors and Vendor Activity ................................ 36
Merging Duplicate Vendors ........................................... 41
Accounts Receivable Administration ................................ 42
Merging Duplicate Clients ............................................ 42
Generating Fixed Amount Automatic Payments .................. 43
Fixed Assets Administration .......................................... 47
Purging Assets ......................................................... 47
Switch to Mid-Quarter Convention ................................... 48
Asset Inventory ......................................................... 49
Student Billing Administration ....................................... 58
Status Wizards ......................................................... 58
Adding, Copying, and Deleting Bill Codes ......................... 68
Merge Process ......................................................... 70
Promoting Students ................................................... 86
Managing Billing Groups ............................................. 90
Generating Fixed Amount Automatic Payments .................. 100
Generating Transactions Automatically ......................... 103
Globally Delete Transactions ...................................... 107
Importing from Tuition Management Service ..................... 108
Creating Financial Aid Schedules ................................... 111
Globally Add Hold Codes ........................................... 115
Payroll Administration .............................................................. 116
Accruing Attendance Expenses ............................................... 116
Administration in The Financial Edge contains utilities and housekeeping tools you can use to set up your database, establish system security, import records, globally change records, and post all or selected transactions to General Ledger. You can also view system statistics, check the database for duplicate records, and validate the database.

This chapter is designed to familiarize you with all of the administration utilities found in The Financial Edge. Financial Edge programs include General Ledger, Accounts Payable, Accounts Receivable, Cash Receipts, Fixed Assets, Payroll, and Student Billing. This chapter also includes information about accessing and navigating the Administration page.

For information about importing records, see the Import Guide for The Financial Edge. For information about Accounting Queue, see the Accounting Queue Guide.

Navigating in Administration

The Administration page is the central location for accomplishing administrative tasks. Click Administration on the navigation bar to access the Administration page. Each task available in Administration appears as a link. The links available on the Administration page can vary depending on the program you have open.

You move through the Administration page the same way you move through other areas of the program. To access the different utilities on the page you can click the links. Common areas include the menu bar and toolbar.

For more information about the menu bar, toolbar, and program navigation, see the Program Basics chapter of the Program Basics Guide.
Common Administrative Tasks

Using the maintenance tools available in Administration, you can perform a variety of administrative tasks, such as setting up system security, importing records, globally changing records, viewing system statistics, checking the database for duplicate records, and validating the database.

The tasks described in this section are found in more than one program, while others are specific to one program. Detailed information and procedures for setting up security and globally changing records are found in separate chapters of this guide.

Setting Up Programs in The Financial Edge

Before you begin using General Ledger, Accounts Payable, Accounts Receivable, Cash Receipts, Fixed Assets, Payroll, or Student Billing, you should first set up each program using the Set up link in Administration. The Set up page for each program contains a list of links to areas you should customize before beginning daily operations in The Financial Edge. To find more information about the set up task in which you are currently working, press F1 on your keyboard to access the help file.

Viewing System Statistics

Click the View system statistics link on the Administration page to view up-to-date totals of all your database records and details about certain system processes and activities. For example, statistics in General Ledger include the number of account records and the date of the last post and the user who performed the post.
Viewing system statistics

1. From the Administration page in General Ledger, click View system statistics. The View system statistics screen appears displaying up-to-date statistics about the records, processes, and activities in your database.

2. To return to the Administration page, click Administration on the navigation bar or click Back.

Posting from The Financial Edge
Subsidiary Ledgers to General Ledger

Posting from subsidiary ledgers in The Financial Edge to General Ledger is essentially the same process as posting from General Ledger using the Other Blackbaud Systems tab. The differences are that (1) from General Ledger, you can post from multiple subsidiary ledgers at once and (2) from a subsidiary ledger program, you can save and manage post parameter files to re-use when posting, so you do not have to define post parameters each time you post. You can post transactions alone or simultaneously with other applications, such as the optional module Purchase Orders. You can select to run pre-post reports to verify batches before posting.

You can also create and use post parameter files in queues if you have the optional module Accounting Queue. For more information about queues, see the Accounting Queue Guide.
Posting batches from subsidiary ledgers in The Financial Edge

1. From the Administration page in Accounts Payable, click Post. The Post page appears.

2. If any post parameter files have been saved, they appear in the list. You can either open one of the saved files or create a new file. To create a new post parameter file, click New Post Parameter on the action bar.

3. The New Post Parameter screen appears displaying the General tab.

4. Mark the Post Accounts Payable transactions with this journal code checkbox and select a journal code.

5. If you have the optional module Purchase Orders and you want to post purchase orders, mark Post Purchase Orders transactions with this journal code and select a journal code.

6. To create an export file, mark Create an output file of posted transactions in this format and select a file format. In the Export file name field, enter an export file name or click the ellipsis to browse.

7. On the General tab, you can also customize journal reference formats for debits and credits for each transaction type. In the box on the left, select the transaction type. A grid for the transaction type appears on the right. In the Reference Type column, select Custom. Enter the format in the Journal Reference column. You can select <Default> in the Reference Type column to return to the default format.
8. If you want to post selected transactions, select the Filters tab.

9. In the Post date field of the Include transactions with post dates in this date range frame, you can select a specific date or date range of posted transactions to include. If you select “<Specific range>”, you can specify a start date and an end date.

   If the Start date field is blank, all activity is included up to the end date. If the End date field is blank, all activity from the start date until present is included. If both fields are blank, all activity is included.

10. In the Include transactions with document dates in this range frame, select a date or date range in the Document date field. If you select “<Specific range>”, you can specify a start date and an end date.

11. To filter transactions by record type, choose “Selected” in the Include column for each filter type. The selection screen appears for you to designate specific filters. Make your selections and click OK. You return to the Filters tab.

   For some record types, you can also filter by a range or query.
12. To define how the batch validation and post report appear, select the Format tab.

13. In the first field, select “Use the default Post Report parameters”, “Always ask for a parameter file”, or “Always use this parameter file”.
   - If you select “Use the default Post Report parameters”, the program uses the Post Report parameters established on the Post Options link of the Records Options tab for General Ledger.
   - If you select “Always ask for a parameter file”, you are prompted to select a parameter file each time you post. The Select a Parameter File screen appears listing saved parameter files. You can select to use a saved parameter file or create a new one.
   - If you select “Always use this parameter file”, designate a parameter file to use as the default each time you post. The first time you select this option, the Select a Parameter File screen appears. On this screen, you can select a saved parameter file, add a new one, open a parameter file to edit, or find a parameter file by file name, description, user created by, or date created on.

14. In the next field, select to preview or print the post report. If you select to print the report, designate a printer.

15. To print a control report, mark Print control report on and select a printer.

16. Click Save and Close. The Save Post as screen appears.
17. Enter a name and description for the post parameter file. Mark checkboxes to determine if other users can run or modify the post. Click Save. You return to the Post page in Administration.

18. To print a Batch Validation Report to review before posting, select the parameter file and click Preview on the action bar. When the processing finishes, a validation successful message appears. Click OK and the Batch Validation Report appears.

19. To post, select the parameter file to use and click Post on the action bar.

20. When the processing finishes, a post successful message appears. Click OK.

Importing Records

Importing records is the process in which you move data from other programs into The Financial Edge. Instead of opening a new or existing record and adding information, you place the information in an import file and use Import records to create new records automatically or update existing records. Importing records is particularly useful if your organization maintains multiple databases or if you need to combine two or more databases into one.

For more information about importing records, see the Import Guide for The Financial Edge.

Globally Changing Records

By globally changing data, you can change information in your database based on a group of records you specify. Using Globally change records, you can add, delete, copy, move, swap, replace, partially replace, increase, or decrease values in a field you select.

In General Ledger, you can globally change fields for project, account, and transaction records. In Accounts Payable, you can globally change fields for products, vendors, invoices, credit memos, recurring invoices, purchase orders, receipts, and bank adjustments. In Accounts Receivable, you can globally change records for products and billing items, clients, charges, credits, invoices and invoice line items, refunds, return and return line items, recurring invoices and recurring invoice line items, and payments. You can globally change fields for assets and transactions in Fixed Assets. In Payroll, you can globally change fields for employees, pay types, benefits, deductions, time entries, and flex plan disbursements. In Student Billing, you can globally changes fields for products and billing items, individuals, organizations, students, charges, credits, refunds, advance deposits, financial aid, and billing schedules. After entering the global change information, you can save it in a parameter file. You can then run the same global change again later, or modify it and run it.
Searching for Duplicate Records

Using Search for duplicates, you can view duplicate criteria and report on duplicate records. You can search for duplicate projects in General Ledger, if you have the optional module Projects and Grants; duplicate vendors in Accounts Payable; duplicate clients in Accounts Receivable; duplicate assets in Fixed Assets; duplicate employees in Payroll, and duplicate students, individuals, and organizations in Student Billing.

The criteria used when searching for duplicate records is defined in Business Rules of Configuration. For more information about defining criteria, see the Configuration Guide for the respective program.

Searching for duplicate project records

While this procedure explains how to search for duplicates in General Ledger, you can use the same steps in any program.

1. From the Administration page in General Ledger, click Search for duplicates. The Duplicate Project Report screen appears.

   On this screen you can view the duplicate project criteria defined in Configuration. This criteria can be changed only on the project business rules screen.

   The Field Name and Length columns contain duplicate criteria defined in Configuration. You can change this information on the Business Rules page.

2. To create a query of all duplicate project records, mark Create output query of duplicate records. Once you create an output query, you can access it later in other areas of the program.

3. To preview the report, click Preview. A processing screen appears.

4. If you marked Create output query of duplicate records, the Save Static Query screen appears. If you did not create an output query, proceed to step 7.
a. Enter a name and description and designate whether others can run and modify this query by marking the corresponding checkboxes.

![Save Static Query](image)

b. To save the query, click **Save**. If duplicate project records exist, the Duplicate Project Report screen appears displaying a preview of the report.

5. You can print, refresh, or send the report as email by clicking the corresponding buttons on the toolbar.

6. To close the preview and return to the Duplicate Project Report screen, click the red X.

### Accounting Queue

Using the optional module *Accounting Queue*, you can schedule a sequence of tasks to run automatically and unattended. You can schedule the program to handle these time-consuming tasks overnight or while you are at lunch. Scheduling queues during non-working hours frees your critical resources — workstations and printers — for other tasks during normal working hours.

For more information about using *Accounting Queue*, see the *Accounting Queue Guide*.

### Security Settings

By establishing security rights for your users, you can ensure the validity, consistency, and confidentiality of your data and determine which users can change or delete important records. By limiting viewing rights, you can control who sees sensitive information.

You can access security from **Set up system security** on the Administration page of any program.

Defining security rights for accessing *Administration* and using administrative tools is important for protecting the integrity of your data. The system administrator or supervisor in charge of setting security privileges should assign security rights to users based on specific job requirements. You can control rights to each task available in *Administration*. For more information about security rights, see “Security” on page 143.
Validating Your Database

We recommend validating your database on a regular basis. During the validation process, the program scans your database tables to determine if data corruption or inconsistencies are present. Errors may occur when software packages or operating systems corrupt your computer’s memory, or hardware problems corrupt the database file.

As a precaution, we recommend running a backup before validating your database. All users must be logged out of the database prior to starting the validation. Because the process can take several hours, we recommend you run it after business hours. Using the delay feature, you can set the start time for the validation to run.

1. From the Administration page in any program, click Validate database. The Database Validation screen appears.

2. To delay the validate database process to a specific time, mark the Delay the validation start time until checkbox and enter a time in the field. Do not mark this option if you want to validate your database immediately.

3. Click Continue. A confirmation screen appears.

4. If you are sure you want to continue, click Yes.

To begin the validation process from the countdown screen regardless of the specified time, click Start Now.

When the validation process begins, a processing screen appears.
When processing is complete, a screen appears informing you that the program has finished validating your database. It also displays the elapsed time of the validation process.

5. To return to the Administration page, click **OK**.

### Creating Consolidation Export Files

*Consolidation Management* is an optional module intended for use by organizations with multiple companies and enables you to generate reports containing consolidated activity for all subsidiaries that are part of a multi-company organization.

To generate consolidated reports, you first need to send account setup information and activity from your subsidiary ledgers to the consolidation database. To do this, you create export files containing account setup information and activity. The export files you create are always Microsoft Access Database files (.mdb).

If you have the optional module *Consolidation Management*, a **Create consolidation export file** link appears on the Administration page. Use this link to create export files from the Administration page of your subsidiary *General Ledger* databases. Once created, access the *General Ledger* consolidation database and import the files. There are two types of subsidiary export files used in *Consolidation Management*: account setup and account activity.

For more information about *Consolidation Management* and creating consolidation export files, see the *Consolidation Management Guide*.

### Electronic Signatures

Electronic signatures are scanned bitmap (*.bmp) images that can be used on *Accounts Payable* checks and purchase orders, *Accounts Receivable* receipts, *Cash Receipts, Payroll* checks, and *Student Billing* receipts. In *Administration* in *Accounts Payable, Accounts Receivable, Cash Receipts, Payroll*, and *Student Billing*, you can add a new signature or open, edit, and delete existing signatures. Electronic signature bitmaps can be saved in the database or created with a file path to a specified location.
Creating an electronic signature

1. From Administration page in Accounts Payable, Accounts Receipts, Cash Receipts, Payroll, or Student Billing, click Electronic Signatures. The Electronic Signatures screen appears.

2. Click New Signature. The New Electronic Signature screen appears.

3. In the Description field, enter a description of the signature. For example, “CEO Signature”.

Graphic images for electronic signatures must be in bitmap (*.bmp) format and no larger than 0.25 inch high and 2.25 inches wide. The program automatically sizes images to fit in the check or purchase order’s allotted space.
4. In the **Status** field, select “Active”.

5. In the **Signature file name** field, enter the file path to the bitmap or click the ellipsis button to search by file name and select the scanned signature.

6. Once a signature file name is selected, the image will appear in the **Signature as it will appear** box. Check this image to verify that you have the correct signature.

7. In the **Include on** box, mark the checkboxes for the checks or purchase orders you want the signature to appear on.

8. To save and close the New Electronic Signature screen, click **OK**. The **Electronic Signatures Screen** appears displaying the new electronic signature and its settings.

9. To return to the Administration page, click **Close**.
10. If you have the optional module Advanced Security, you can set user rights to electronic signatures. For more information about security users, see “Security for Users” on page 162.

**General Ledger Administration**

Tasks that appear on the Administration page only in General Ledger include summarizing, purging, and closing fiscal years, entering and locking beginning balances, and updating fund transaction requirements. When posting to General Ledger from the Administration page in General Ledger, you can post batches and post from multiple subsidiary ledgers at once.

**Posting in General Ledger**

Posting a batch adds transaction entries to ledger accounts and updates account balances. You can post batches from Journal Entry or Administration in General Ledger, or from Administration in Accounts Payable, Accounts Receivable, Cash Receipts, Fixed Assets, Payroll, or Student Billing.

In General Ledger, when posting through Journal Entry, you can post only one batch of transactions at a time. However, when posting through Administration, you can post multiple batches at the same time.

By selecting the Post link in Administration for General Ledger, Accounts Payable, Accounts Receivable, Cash Receipts, Fixed Assets, Payroll, or Student Billing, you can post all or selected transactions to General Ledger. You can also post Accounts Payable, Accounts Receivable, Cash Receipts, Fixed Assets, Payroll, or Student Billing transactions alone or simultaneously with other applications, such as the optional module Purchase Orders.

**Batch Validation Requirements**

The primary function of the batch validation process is to make sure batches are in balance. When the validation process is initiated, the program reviews each transaction to ensure all required fields are entered and each entry meets certain requirements. In most instances, individual transactions and account information entered into The Financial Edge will be validated individually upon data entry. However, you can use the validation process to confirm that batches are in balance by each required factor.

**Balancing Requirements**

You can post only a balanced batch to General Ledger. Validating a batch verifies the batch is in balance by these factors:

- **Fund** - A batch must be in balance by fund.
- **Period** - Debit and credit transactions must balance by accounting period. Periods used on transactions may not be closed.
- **Amount** - The total of all debit transactions must equal the total of all credit transactions.
- **By period within fund** - Batches which contain transactions for more than one period will be checked to make sure the debit and credits within each fund are in balance for each period.
• Journal - Transactions must balance by journal reference value.
• Projects - If you are using the optional module Projects, you may have to balance by project if Require to Balance is marked for the related fund.
• Segment - You may have to balance by segment if Require to Balance is marked for the related fund.
• Class - You may have to balance by class if Require to Balance is marked for the related fund.
• Transaction codes - You may have to balance by transaction codes if Require to Balance is marked for the related fund.
• Type - A batch must balance by regular or encumbrance type.

Validation checks the status of accounts and projects in the batch. They must be marked as active. To change the account or project status, select the line in the batch record. From the Batch menu, select Go to and Account or Project. The record opens and you can make the necessary changes.

Validating and Posting Regular Batches in General Ledger

Using the Post link in Administration in General Ledger, you can post two kinds of transaction batches: regular batches and batches from subsidiary ledgers in The Financial Edge. For information about posting batches from subsidiary ledgers, see “Posting From Other Blackbaud Systems” on page 18 and “Posting from The Financial Edge Subsidiary Ledgers to General Ledger” on page 5.

Validating and posting a regular batch in General Ledger

1. From the Administration page in General Ledger, click Post. The General Ledger Post screen appears on the Regular Batches tab.

2. By default, the grid displays only open batches with zero balances. To show all open batches regardless of balance amount, unmark the Only show zero balances checkbox.

3. Mark the Post checkbox for each batch you want to validate and post.
4. In the Post Options frame, select “Validate and post” for the selected batches.

5. To receive a confirmation message after each selected batch is validated, mark Confirm validation after each batch. With this feature, you determine whether to post or skip a batch during processing.

6. Select whether to print or preview the Batch Validation Report. If you select “Print report on”, select a printer.

7. To print a Post Control Report after the posting process, mark Print control report on and select a printer.

8. To begin the validation process, click Process Now. A processing screen appears. If you marked Confirm validation after each batch on the previous General Ledger Post screen, a message appears for each batch telling you if the batch was valid or not. You can cancel or continue processing each batch that does not validate.

When all batches have processed, the Post screen appears displaying the number of batches posted and the number that failed validation.

9. To exit the Post screen and return to the General Ledger Post screen, click Close.

Posting From Other Blackbaud Systems


You cannot post the 6.x subsidiary ledgers, Student Billing and Payroll, from General Ledger. All 6.x subsidiary ledgers must be posted from Utilities and Housekeeping in the subsidiary program.

To post batches from subsidiary ledgers in The Financial Edge, from General Ledger, select the Other Blackbaud Systems tab on the General Ledger Post screen. You can select to post from multiple programs, and select to use saved parameter files or to define parameters as you proceed.

A subsidiary ledger is a record of the original financial transactions that in total equal the balance of a control account in the general ledger.

Select “Validate only” in the Post Options frame to validate without posting.
If defining parameters as you proceed, you make selections and enter information related to each subsidiary ledger on three tabs on the Post to General Ledger screen: General, Filters, and Format. These tabs help you select information specific to each subsidiary ledger in The Financial Edge to be posted to General Ledger. For example, on the General tab of Accounts Payable, you can specify the journal reference to use for each type of transaction. Keep in mind that journal references, options, fields, and other selections for each tab on the Post to General Ledger screen vary from one program to another in The Financial Edge.

General tab. On the General tab, you select journal codes and journal references for the transactions you want to post. Journal codes are defined in Configuration in General Ledger. A grid displays default journal references for each transaction type. Journal references are defined on the Posting Information link of Configuration in Accounts Payable, Accounts Receivable, Cash Receipts, Fixed Assets, Payroll, and Student Billing. On the General tab, you can select Custom in the Reference Type column to enter a different journal reference.

Filters tab. On the Filters tab, you include transactions to be posted based on selected criteria. You can filter by post date or document date. You can also filter by record type and include all or selected records.


- Posting a batch from another Blackbaud system

1. From the Administration page in General Ledger, click Post. The General Ledger Post screen appears.
2. Select the Other Blackbaud Systems tab.

While this procedure demonstrates how to post Accounts Payable transactions from the Other Blackbaud Systems tab, the steps can be used as a model for all subsidiaries in The Financial Edge.

You must complete the Post to General Ledger screens for each program you selected to post and to define post parameters.

3. In the Post column, mark the checkbox for each The Financial Edge subsidiary ledger from which you want to post. For example, mark the box for Accounts Payable.

4. In the Post Parameters column, you can select a saved post parameter file defined on the Post link in Administration for each program, or select "<Define Post Parameters>" to define the parameters as you continue in this procedure.

5. Click Process Now. If you selected pre-defined post parameter files, the processing begins immediately. If you selected to define post parameters, the Post to General Ledger screen appears.

6. Mark the Post Accounts Payable transactions with this journal code checkbox and select a journal code.
7. If you have the optional module *Purchase Orders* and you want to post purchase orders, mark *Post Purchase Orders transactions with this journal code* and select a journal code.

8. To create an export file, mark *Create an output file of posted transactions in this format* and select a file format. In the *Export file name* field, enter an export file name or click the ellipsis to browse.

9. On the General tab, you can also customize journal reference formats for debits and credits for each transaction type. In the box on the left, select the transaction type. A grid for the transaction type appears on the right. In the *Reference Type* column, select Custom. Enter the format in the *Journal Reference* column. You can select <Default> in the *Reference Type* column to return to the default format.

10. Select the Filters tab.

11. In the *Post Date* field of the *Include transactions with post dates in this date range* frame, you can select a specific date or date range of posted transactions to include. If you select “<Specific range>”, you can specify a start date and an end date.

   If the *Start date* field is blank, all activity is included up to the end date. If the *End date* field is blank, all activity from the start date forward, including transaction with a future post date, is included. If both fields are blank, all activity is included.

12. In the *Include transactions with document dates in this range* frame, select a date or date range in the *Document date* field. If you select “<Specific range>”, you can specify a start date and an end date.
13. To filter transactions by record type, choose “Selected” in the Include column for each filter type. The selected <Filter> screen appears for you to designate specific filters. Make your selections and click OK. You return to the Filters tab.

14. Select the Format tab.

15. In the first field, select “Use the default Post Report parameters”, “Always ask for a parameter file”, or “Always use this parameter file”.

   • If you select “Use the default Post Report parameters”, the program uses the Post Report parameters established on the Post Options panel of the Records Options tab for General Ledger.

   • If you select “Always ask for a parameter file”, you are prompted to select a parameter file each time you post. The Select a Parameter File screen appears listing saved parameter files. You can select to use a saved parameter file or create a new one.
• If you select “Always use this parameter file”, designate a parameter file to use as the default each time you post. The first time you select this option, the Select a Parameter File screen appears. On this screen, you can select a saved parameter file, add a new one, open a parameter file to edit, or find a parameter file by file name, description, user created by, or date created on.

16. In the next field, select to preview or print the post report. If you select to print the report, designate a printer.

17. To print a control report, mark Print control report on and select a printer.

18. To print a Batch Validation Report to review before posting, click Pre-Post Report. When the processing finishes, a validation successful message appears. Click OK and the Batch Validation Report appears.

19. To begin the posting process, click Post Now.

20. When the processing finishes, a post successful message appears. Click OK.

Fiscal Year-End Procedures

Fiscal year-end procedures include processes and information for pre-closing, closing, summarizing, and purging fiscal years in General Ledger.

Pre-Closing and Closing Fiscal Years

The purpose of closing a fiscal year is to update the net asset accounts in the balance sheet with income statement activity. At the end of the year, General Ledger adds all income statement transactions together to calculate the net surplus/deficit for the year. It then “zeros” income statement account balances by transferring the net surplus or deficit to the appropriate net asset accounts. In balance sheet accounts, ending balances roll forward to the next fiscal year.

You can also pre-close a fiscal year. A pre-closing is a mock closing that can be used to temporarily close a year in order to speed reporting. Because closing a fiscal year is permanent, we encourage you to pre-close each fiscal year as soon as you finish entering and posting all transactions for the year before running the actual closing process.

Once you close a fiscal year, information remains available for reporting until it is purged. However, you cannot post new activity to a closed year. We recommend you back up your database before closing fiscal years.

➢ Pre-closing or closing a fiscal year

1. From the Administration page in General Ledger, click Close fiscal years. The Close Fiscal Year screen appears.
If users are currently logged into the program, a list of those users is displayed. All users must exit the program before you can run the pre-closing or closing process. Once all users exit the program, the Close Fiscal Year screen appears.

Because closing a fiscal year is permanent, we encourage you to pre-close before running the actual closing process.

2. In the Action field of the Closing Options frame, select “Print pre-close report”, “Pre-close fiscal year”, or “Close fiscal year”.

3. In the Fiscal year field, select the fiscal year to pre-close or close.

4. In the Action field of the Report Options frame, select “Preview Report” or “Print Report”. If you select “Print Report”, also select a printer.

5. In the Orientation field, select “Portrait” or “Landscape” depending on how you want the report to appear for printing or previewing.

6. Select the Fund filter tab.

7. In the Include column, select “All” or “Selected”. If you choose “Selected”, the Selected Funds screen appears for you to select the funds to close.
8. Make your selections and click **OK**. You return to the Filters tab and the filters appear in the **Selected Filters** column.

9. Click **Run Now**. If you selected “Print pre-close report” on the General tab, the End of Year Report generates. If you selected “Pre-close fiscal year” or “Close fiscal year”, a screen appears confirming you want to pre-close or close the fiscal year.

10. To continue pre-closing or closing the fiscal year, click **Yes**.

   If the program detects errors during the pre-closing or closing process, you can view the End of Year Error Report to see where problems exist. To return to the Close Fiscal Year screen, close the report. This report prints automatically without previewing it, if you choose that report option.

   If the pre-close or close process is successful, a confirmation message appears.

11. Click **OK** to process the End of Year Report, which appears for you to preview or prints depending on the report options you select. If you preview the report, you can return to the Close Fiscal Year screen by closing the report. If you print the report, the program automatically returns to the Close Fiscal Year screen.

### Summarizing Fiscal Years

To save space in your database, you can use **Summarize fiscal years** to summarize all transactions for closed fiscal years. During the summarizing process, the program removes all transaction detail, including associated distributions. The program does, however, save the beginning and ending balances as well as the total net change for the project, class, and transaction code distribution for each fiscal period.

---

**Once a fiscal year is successfully pre-closed or closed, the status for that year will be “Pre-Closed” or “Closed” on the Fiscal Years page in **Configuration**.**

---

**All transaction detail for a fiscal year is removed if you summarize the fiscal year. You cannot restore the detail without restoring to a previous database.**
You must close the fiscal year before you can summarize it.

Once you summarize a fiscal year, you can produce reports on the beginning and ending balances as well as the net change and net asset class for each account. If you have the optional module Projects and Grants, you can also produce reports on transaction codes and projects.

∑ Summarizing a closed fiscal year

1. From the Administration page in General Ledger, click Summarize fiscal years. The Summarize Fiscal Year screen appears.

2. In the Summarize all fiscal years through field, select the closed fiscal year you want to summarize.

3. To delete batch headers if all transactions within a batch are summarized, mark the checkbox.

4. Click Summarize Now. A confirmation message appears.

5. To continue, click Yes. A processing screen appears. Once the process is complete, a confirmation message appears.

6. To return to the Administration page, click OK.

Purging Fiscal Years

By purging a fiscal year, you remove all detail about the fiscal year from your database. However, the program does not delete any account numbers and tables used in a fiscal year. You must close a fiscal year before it can be purged. Before purging a fiscal year, you should run all financial statements and save or print copies for your records. We also strongly recommend you create a backup of your database prior to purging. You cannot recover a purged fiscal year without restoring to a backup.

∑ Purging a fiscal year

1. From the Administration page in General Ledger, click Purge fiscal years. The Purge Fiscal Year screen appears.
2. In the **Purge all fiscal years through** field, select the closed or summarized fiscal years to purge.

3. Click **Purge Now**. A confirmation message appears.

4. To continue the purging process, click **Yes**. A processing screen appears. Once purging is complete, a confirmation message appears.

5. To return to the Administration page, click **OK**.

### Beginning Balances

In **General Ledger**, you can enter and lock beginning balances one fund at a time. In addition, because you can enter regular and encumbrance amounts for Income Statement accounts, you can also enter beginning balances starting with any period. You enter beginning balances only once. You cannot change the beginning balance after you lock it.

As long as the balances have not yet been locked, you can also edit existing account beginning balances for each fund. After you enter the correct beginning balances for accounts in **General Ledger**, you can lock beginning balances from the **Tools** menu on the Enter Beginning Balances screen or use the **Lock beginning balances** link on the Administration page. Once you lock the balances, you cannot edit them.

### Entering Beginning Balances

After you define accounts, you can enter beginning balances by fund. You can distribute beginning balances by class, transaction code, or project. Distributing balances by projects or transaction codes is available only if you have the optional module **Projects and Grants**. You can also enter beginning balances for balance sheet and income statement accounts. In addition, you can create accounts “on the fly” as long as you define each segment value for the accounts in **Configuration**.

You can enter beginning balances for only one fiscal year; therefore, we recommend you select the oldest year for which you want to generate reports. You can enter beginning balances as of the beginning or middle of a fiscal year. To a large extent, the method you use to determine and enter beginning balances determines the reports you can generate.

You can run a Trial Balance Report from the Enter Beginning Balances screen for the open fund that lists each account balance and shows whether the total amount of debits equals the total amount of credits. You can also validate account balances and characteristics prior to locking the balances by selecting validate from the **Tools** menu. For more information about the Trial Balance Report, see the **Reports Guide for General Ledger**.

If you are unsure of the actual beginning balance, you can enter and lock the beginning balance at zero. You then enter beginning balances through manual journal entry. With this method, you can post activity to the general ledger before entering the beginning balance. If you lock a beginning balance at zero, reports run for the fiscal year in which they were locked show a zero beginning balance.
Entering beginning balances

1. From the Administration page in General Ledger, click Enter beginning balances. The Enter Beginning Balances screen appears.

2. In the Fund field, enter the ID of the fund for which you want to enter beginning balances or click the binoculars to search for the fund ID.

3. In the Fiscal Year field, select the fiscal year for which you want to enter beginning balances. You can enter beginning balances for only one fiscal year.

4. In the Period field, select the fiscal period for which you want to enter beginning balances.

5. Click Load Now. The Enter Beginning Balances screen appears. On this screen, a grid displays any accounts created for that fund. The account description appears automatically. If you have not yet created accounts, the grid is blank.

6. If you have the appropriate security rights, you can create new accounts in the Account Number column. The program validates any accounts created “on the fly” when you leave the account cell. The account’s description appears in the Description column.
7. In the **Type** column, specify whether the amount is regular or encumbrance.

8. If the account’s beginning balance is a debit amount, enter the amount in the **Debit Amount** column. Typically, asset accounts have a beginning debit balance.

9. If the account’s beginning balance is a credit amount, enter the amount in the **Credit Amount** column. Typically, liability and fund balance accounts have a beginning credit balance.

10. If you have the optional module *Projects and Grants* and are closing by project, you must assign project distributions to all accounts (or all income statement accounts) if required on the fund. It is very important that your fund balance (net assets) account is properly distributed to each project or transaction code.

11. To exit and return to the Administration page, click **Save and Close**.

➤ **Running a Trial Balance Report**

After entering account balances, we recommend you run a Trial Balance Report from the Entering Beginning Balances screen to see account balances and if the debits and credits balance. For more information about the Trial Balance Report, see the *Reports Guide for General Ledger*.

1. From the Administration page in *General Ledger*, click **Enter beginning balances**. The Enter Beginning Balances screen appears.

2. To print the report, from the menu bar, select **File**, **Print**, or to preview the report, select **File**, **Print Preview**. The Select a Parameter File screen appears.

You can enter only one amount per account in either the **Debit Amount** or **Credit Amount** column.

The **Project ID** and **Project Description** columns appear on the Enter Beginning Balances screen only if you have the optional module *Projects and Grants*. 
3. If you have a saved Trial Balance parameter file to use, select the file and click **Select**. If you do not have a saved parameter file, click **Add New**. The New Trial Balance Report screen appears.

4. To create the report, make the appropriate selections on the General, Filters and Format tabs. For more information about creating a Trial Balance report, see the *Reports Guide for General Ledger*.

5. To save the parameter file, from the menu bar, select **File, Save**. The Save report as screen appears.

6. Give the parameter file a name and description. To give others rights to run or modify this report parameter file, mark **Others can run this report** and **Others can modify this report**. Click **Save** to return to the report parameter file.

7. To return back to the Select a Parameter File screen, select **File, Close**.

8. Select the parameter file and click **Select**. The report prints or previews...
Locking Beginning Balances

By locking beginning balances, you lock the account balance amounts as well as the project, class, and transaction code distributions entered on the Enter Beginning Balances screen. You can lock beginning balances for all or selected funds.

When you lock beginning balances, General Ledger validates each fund and all closing characteristics to confirm that they exist and are in balance. The validation process verifies that a fund’s assets equal the sum of the liabilities and net assets. More specifically, the validation process verifies all projects, classes, and transaction codes are balanced as required on each fund. Validation also confirms that regular debits equal regular credits and all encumbrance debits equal encumbrance credits.

The trial balance for each fund must be in balance before you can successfully lock data. General Ledger will not lock balances that create an out-of-balance ledger.

In General Ledger, you can enter transactions into Journal Entry batches before locking balances, but you cannot post batches unless all funds are locked for all accounts used in those transactions. You can, however, lock only one fund to start entering transactions, but you can post those batches only if all transactions use accounts only from that locked fund. If you use accounts from other funds you will receive an error message.

For all Financial Edge subsidiaries, if at least one fund is locked, you can enter transactions using accounts in that fund only. You cannot enter activity for funds that are not locked. You will receive an error message and will not be able to save the transaction.

Once you lock balances, the program posts transactions as of the beginning fiscal period for the selected fund. Also, once you lock beginning balances for a fund, you cannot revise or add a beginning balance to any account in the fund.

Considerations to Make Before Locking Beginning Balances

- Back up database files. This step is crucial. Once you lock beginning balances, you cannot undo the process; however, creating a backup allows you to restore the database to its state before beginning balances were locked.
- Verify that you set up all funds correctly and designated a fund balance account for each fund.
- Verify that the beginning balances are entered correctly for each account. You can verify this information by printing and reviewing a Trial Balance Report for each fund.
- If you use projects on any funds, verify that the correct beginning balances are entered for each project. You can print a trial balance for each project.
- If you use transaction codes on any funds, verify that the correct beginning balances are entered for each transaction code. You can print a trial balance for each transaction code.
We strongly recommend you make a backup of your database files before you lock beginning balances. Once you lock beginning balances, you cannot undo the process. However, you can use a backup to restore data to its state prior to locking beginning balances.

➢ Locking beginning balances

1. From the Administration page in General Ledger, click **Lock beginning balances**. The Lock Beginning Balances screen appears on the General tab.

   On this tab, you define report options for the Validation Error Report and the Lock Beginning Balances Control Report.

   ![Lock Beginning Balances Screen](image)

2. In the **Action** field, select to print or preview the reports. If you choose to print the reports, select a printer from the corresponding field.

3. In the **Orientation** field, select “Portrait” or “Landscape”.

4. Select the Funds tab.

   ![Funds Tab](image)

5. In the **Lock?** column, mark the checkbox next to the fund for which to lock beginning balances.
6. In the **Fiscal Year** column, select the year for which to lock beginning balances. Defaults are based on information initially entered.

7. In the **Fiscal Period** column, select the fiscal period for which to lock beginning balances. Defaults are based on the fiscal period selected when beginning balances were selected.

8. The **Lock As Of** column displays the date that the beginning balances will be locked. To change this date, select the fund and click **Change Dates** on the action bar. The Change Dates screen appears.

![Change Dates](image)

9. Select a new fiscal year and period. To enter the new lock date and return to the Lock Beginning Balances screen, click **OK**.

10. Once you are ready to lock beginning balances, click **Lock Now**. A processing screen appears while the system validates the fund information.

    If validation is successful, a confirmation message appears. To continue locking beginning balances, click **Yes**.

    If validation fails, the Validation Error Report either appears in a preview screen or prints, depending on the report options you selected on the General tab of the Lock Beginning Balances screen.

11. Once locking process is finished, the Lock Beginning Balances screen appears confirming the process is complete.

![Lock Beginning Balances](image)

12. To preview or print the Lock Beginning Balances Control Report, click **Control Report**. To return to the Lock Beginning Balances screen, click **Close**.
Updating Fund Transaction Requirements

On the Update fund transaction requirements screen, you can update transaction history by adding new transaction characteristics. You have the ability to add or modify fund transaction requirements, fund closing requirements, and transaction history. Updating fund records through this process is necessary only if you have locked beginning balances. If beginning balances are not locked, you can update the fund directly. Updates made to a fund are recorded on the fund’s History of Changes tab in Configuration.

When you update transaction requirements using the Update Fund transaction requirements link, the program updates:

- Posted and unposted transactions for open fiscal years.
- Transactions for closed fiscal years.
- Summarized transactions for closed fiscal years.
- Beginning balances for the earliest fiscal year.

 Updating fund transaction requirements

1. From the Administration page in General Ledger, click Update Fund transaction requirements. The Update fund transaction requirements screen appears.

2. In the Update field, select the characteristic to update. This field displays all class, project, and transaction code characteristics found on the fund’s Transaction Requirements tab in Configuration. These characteristics are table entries defined in Configuration, so the options that display in this field depend on what is defined for your organization’s system. Projects and transaction codes appear only if you have the optional module Projects and Grants.

3. In the Fund ID field, enter the fund ID or click the binoculars to search for the fund to be updated.

Once you make selections in the Update and Fund ID fields, the current settings for all other fields and options appear for that fund. You can change any current setting by making a different selection.
4. In the **Require on** field, select the accounts to be included in the update: “All Accounts”, “No Accounts”, or “Income Statement Accounts”. If the current setting for this field is “Do Not Require”, select “No Accounts”.

5. If you select to update “All Accounts” or “Income Statement Accounts” in the **Require on** field, you must select a default value. The default value will be assigned to previous transactions that do not have the new requirement.

The selections in the **Default value** field depend on your selection in the **Update** field. For example, if you select “Class” in the **Update** field, the **Default value** field options are “Unrestricted Net Assets”, “Temporarily Restricted Net Assets”, or “Permanently Restricted Net Assets”. Default values are required only if the characteristic is required to balance.

6. To require a transaction’s debits and credits to balance by a fund characteristic, mark the **Require to balance** checkbox. This does not mean the characteristic is required on each transaction. Use attributes to require the characteristic on each transaction.

7. To close the fund to a net asset account and distribute information by fund characteristics when closing the fiscal year, mark **Preserve details during closing**. If this checkbox is not marked, information for the characteristic is not carried forward when you close the fiscal year.

8. If you want to apply the default value to existing accounts, mark **Apply default value to existing accounts**.

9. To preview the changes, click **Preview Change**. The Preview Fund Update screen appears.

10. To update the fund requirements, click **Change Now**. A message screen appears to confirm the update information.

11. To confirm the update is correct, click **Yes**. A confirmation message appears.

12. To complete the update and return to the Administration page, click **OK**.
Accounts Payable Administration

Tasks that appear on the Administration page only in *Accounts Payable* include purging vendor activity, purging vendors, and merging duplicate vendors.

Purging Vendors and Vendor Activity

By purging vendors you remove all detail about inactive vendors and corresponding vendor activity from your database. Vendors with open activity cannot be purged. Active and On hold vendors can be purged if the vendor activity for those vendors meet certain requirements.

Vendor activity that can be purged includes:

- Transactions marked as Posted or Do Not Post.
- Fully resolved transactions: invoices and credit memos must be paid in full; checks cleared or voided; recurring invoices fully generated or marked inactive; and purchase orders closed.
- Transactions with transaction dates on or before the cutoff date specified on the General tab.
- Deleted invoices, credit memos, and purchase orders whose transaction date occurs on or before the cutoff date.

Vendor activity that cannot be purged include:

- Transactions linked to other ineligible transactions. For example, the transaction cutoff date is 6/30/02. An invoice is dated 6/15/02, but paid with a check dated 7/01/02. Neither transaction can be purged because the check’s date does not fall within the specified period.

There are two exceptions to the rules for purging vendors. You cannot purge vendors with 1099 summary information or vendors with open-ended recurring invoices (unless marked as inactive). However, you can override these rules by marking the exception options on the General tab of the Purge Vendors screen.
Purging vendor activity

1. From the Administration page in *Accounts Payable*, click **Purge vendor activity**. The Purge Vendor Activity screen appears on the General tab.

2. To exclude vendor activity created after a certain date, enter that date in the **Purge vendor activity with transaction date before** field.

3. To create a query of all vendors excluded because of vendor activity that did not meet purging requirements, mark the **Create exception query of vendors** checkbox.
4. To print a control report after purging, mark the checkbox and select a printer. The control report displays all vendor transactions that were purged.

5. Select the Filters tab.

6. In the **Include** column, select to include “All” or “Selected” vendors or vendor attributes. If you choose “Selected”, the selected <filter> screen appears for you to designate specific filters.

7. Make your selections and click **OK**. You return to the Filters tab and the filters appear in the **Selected Filters** column.
8. To verify the vendor activity to be purged, click **Pre-Purge Report**. The Pre-Purge report lists vendors to be purged and those that will not be purged and the reason why.

9. Click **Purge Now**. A confirmation message appears.

10. To continue the purging process, click **Yes**. A processing screen appears. Once purging is complete, a confirmation message appears.

11. To return to the Administration page, click **Close**.

➤ **Purging vendors**

1. From the Administration page in *Accounts Payable*, click **Purge vendors**. The Purge Vendors screen appears on the General tab.

2. In the **Purge vendors with these statuses** box, mark **Active**, **Inactive**, or **On hold**. **Inactive** is marked by default.

3. In the **Purge vendors that were created before** field, enter a cut-off date for vendors to be purged.

4. To override the purging rules and allow vendors with 1099 adjustments in the current year or vendors with inactive, open-ended recurring invoices to be purged, mark the checkboxes.

5. To create a query of all vendors excluded because they did not meet the purging requirements, mark **Create exception query of vendors**.
6. To print a control report displaying all vendors to be purged, mark the checkbox.

7. Select the Filters tab.
8. In the **Include** column, select “All” or “Selected”. If you choose “Selected”, the selected <Filter> screen appears for you to designate specific filters.

9. Make your selections and click **OK**. You return to the Filters tab and the filters appear in the **Selected Filters** column.
10. To verify the list of vendors to be purged, click **Pre-Purge Report**.

11. Click **Purge Now**. A confirmation message appears.

12. To continue the purging process, click **Yes**. A processing screen appears. Once purging is complete, a confirmation message appears.

13. To return to the Administration page, click **Close**.

### Merging Duplicate Vendors

Once you identify duplicate vendor records, you can merge information from a duplicate vendor to a primary vendor to create one complete vendor record. Numerous types of information can be merged, including bank information, activity, attributes, distributions, and adjustments. For more information about searching for duplicate records, see “Searching for Duplicate Records” on page 10.

- **Merging duplicate vendors**

  Select to merge information from a duplicate vendor with information from a primary vendor.

1. From the Administration page in **Accounts Payable**, click **Merge Vendors**. The Merge Vendors screen appears.

2. In the **Duplicate vendor** field, enter the vendor’s name or use the binoculars to search for the name.

   The duplicate vendor is the vendor whose record information is merged into the primary vendor’s information. The duplicate vendor is deleted after the merging process.

3. In the **Primary vendor** field, enter the vendor’s name or use the binoculars to search for the name.

   The primary vendor is the receiving vendor who will receive the merged information and whose record will not be deleted.
4. To merge the vendor records, click Merge Now. A confirmation message appears. Click Yes to continue merging or No to return to the Merge Vendors screen.

5. If you select Yes, after the merge is complete, a message appears asking if you want to merge another pair of vendors. Click Yes and the screen resets to create another merge. Click No and the screen closes and returns to the Administration page.

Accounts Receivable Administration

A task that appears on the Administration page only in Accounts Receivable is merging duplicate clients.

In Accounts Receivable, you can also generate fixed amount automatic payments.

Merging Duplicate Clients

Once you identify duplicate client records, you can merge information from a duplicate client to a primary client to create one complete client record. You can merge individual client records only with another individual client record, and organization records only with another organization record. Numerous types of information can be merged, including addresses, activity, attributes, and annotations. For more information about searching for duplicate records, see “Searching for Duplicate Records” on page 10.

Merging duplicate clients

Select to merge information from a duplicate client with information from a primary client.

1. From the Administration page in Accounts Receivable, click Merge Clients. The Merge Clients screen appears.

2. In the Duplicate client field, enter the client’s name or use the binoculars to search for the name.

   The duplicate client is the client whose record information is merged into the primary client’s information. The duplicate client is deleted after the merging process.

3. In the Primary client field, enter the client’s name or use the binoculars to search for the name.
The primary client is the receiving client who will receive the merged information and whose record will not be deleted.

4. To merge the client records, click **Merge Now**. A confirmation message appears. Click **Yes** to continue merging or **No** to return to the Merge Clients screen.

5. If you select **Yes**, after the merge is complete, a message appears asking if you want to merge another pair of clients. Click **Yes** and the screen resets to create another merge. Click **No** and the screen closes and returns to the Administration page.

**Generating Fixed Amount Automatic Payments**

Fixed automatic payments are set up on a regular schedule for a pre-determined amount. By generating fixed amount automatic payments, you create fixed amount payments for selected client records. For each client selected in the payment run, *Accounts Receivable* automatically creates one deposit record for the process and a payment record for each of the fixed amount scheduled payments.
Generating fixed amount automatic payments

1. From the Administration page in *Accounts Receivable*, click **Generate fixed amount automatic payments**. The Generate Fixed Amount Automatic Payments screen appears.

2. To include payments for specific dates in fixed schedules, mark **For fixed schedules, include payments with these dates**. In the *Dates* field, select a date or a date range.

3. To include payments with unlimited schedules, mark **For unlimited schedules, include payments that meet this criteria**. In the field under the checkbox, select “Generate payments through” and enter a date or select “Generate specific number of payments” and enter a number.

4. In the filters grid, you can filter the records included in the processing. For more information about filtering criteria, see the *Program Basics Guide*.

5. To create an output query of the payment records included, mark **Create output query of payment records** checkbox.
6. Select the Deposit tab to enter information for the deposit record created in this process.

7. In the **Deposit date** field, enter a transaction date for the deposit.

8. In the **Entry date** field, enter an entry date for the deposit.

9. In the **Status** field, select “Open” or “Closed.”

10. In the **Description** field, enter a description of the deposit.

11. In the **Post status** field, select “Not yet posted” or “Do not post”.

12. In the **Post date** field, enter a posting date for the deposit.

13. In the **Bank account** field, select a **Accounts Receivable** bank account.

   The **GL cash account** field displays the cash account assigned to the selected **Accounts Receivable** bank account.

14. In the **Projected Deposit Totals** frame, enter numbers in the **Projected # of payments** and **Projected total** fields. You can use these numbers as accuracy checks before posting.
15. Select the Payment tab to enter information for the payment records created in this process.

16. In the Payment date field, select “Use scheduled date” or select “Use specific date” and enter the date. The Post status and Post date fields display the post information for the payment.

17. In the Source field, select a payment source.

18. In the Comment field, enter a comment.

19. Click Preview to view payment records. The Payments to Generate screen appears.
20. In the Generate column, unmark the checkboxes for any payments you
do not want to generate.

21. When you are ready to generate payments, click Generate Now.

22. A confirmation message appears when the process is complete. Click OK
to return to the Administration page.

Fixed Assets Administration

Tasks that appear on the Administration page only in Fixed Assets include
purging assets, switching to a mid-quarter convention, and creating an asset
inventory.

Purging Assets

Using Purge Assets in Fixed Assets, you can remove any asset that has been fully
depreciated or disposed. All transactions for the asset must be marked as Do not
post or Posted. You can view a pre-purge report to verify the list of assets to be
purged. A control report automatically prints after purging that lists all assets
removed during the process. You cannot recover purged assets without restoring
to a backup.

➢ Purging fixed assets

1. From the Administration page in Fixed Assets, click Purge Assets. The
Purge Assets screen appears on the General tab.

2. To create a query of all assets excluded because they did not meet the
purging requirements, mark Create exception query of assets.

3. To print a control report displaying all assets to be purged, mark Print a
control report on and select a printer.

We strongly recommend creating a
backup before purging
assets. You cannot recover
purged assets without
restoring to a backup.
4. Select the Filters tab.

5. In the Include column, select “All” or “Selected”. If you choose “Selected”, the selected <Filter> screen appears for you to designate specific filters.

6. Make your selections and click OK. You return to the Filters tab and the filters appear in the Selected Filters column.

7. To verify the list of assets to be purged, click Pre-Purge Report.

8. Click Purge Now. A confirmation message appears.

9. To continue the purging process, click Yes. A processing screen appears. Once purging is complete, a confirmation message appears.

10. To return to the Administration page, click Close.

**Switch to Mid-Quarter Convention**

Switching to mid-quarter convention in *Fixed Assets* involves two functions: determining whether mid-quarter convention applies to the selected year and switching all applicable assets put into service in the selected year to a mid-quarter convention. Only assets put into service in the selected year that use MACRS with a half-year convention will be switched.

You must use the mid-quarter convention if during the year the total bases of depreciable property placed in service during the last quarter of the year exceeds 40 percent of the total bases of all depreciable property placed in service during the year. Once assets are switched to the mid-quarter convention, the program zeros out all year-to-date period depreciation for new assets that use the half-year convention and recalculates depreciation using a mid-quarter convention.
Switching to mid-quarter convention

1. From the Administration page in *Fixed Assets*, click **Switch to Mid-Quarter Convention**. The Switch to Mid-Quarter Convention screen appears.

![Switch to Mid-Quarter Convention](image)

2. In the **Year** field, select the year to switch to or test for mid-quarter convention.

3. To run the mid-quarter test before switching, mark **Confirm that IRS requirements are met before switching**. If you do not mark this option, the program automatically switches to mid-quarter without testing.

4. To create an output query of all assets switched to mid-quarter convention, mark the checkbox.

5. To begin the test or switch, click **Switch to mid-quarter convention**.

6. If you marked **Confirm that IRS requirements are met before switching**, a screen appears stating whether the selected year meets or fails the mid-quarter test.

7. Click **Switch**. A message appears confirming the number of assets switched to mid-quarter.

8. To return to the Administration page, click **Close**.

---

**Asset Inventory**

You can use the Asset Inventory to identify assets that have been moved or are missing by comparing asset records in *Fixed Assets* to an inventory file. Inventory files contain asset numbers or asset IDs and locations or departments for assets that have been inventoried either by scanning or manual counts. The scanning process produces an electronic file, while manual inventory counts must be converted to an electronic file outside of *The Financial Edge*. Using **Asset Inventory**, you can identify which locations or departments have been inventoried and automatically update asset locations or departments.

**Asset Inventory Reports**

You also create preview and print inventory control reports. The control report includes a variety of inventory comparisons. All of these report sections are included by default:

To test for mid-quarter without switching, mark **Confirm that IRS requirements are met before switching**.

If you are only testing, click **Cancel**.

In *Mail*, you can create barcode labels to scan when conducting asset inventories. For more information see the *Mail Guide*. 
• Assets inventoried, location matches control group — Lists asset records in the inventory file and control group with matching asset numbers and the same locations/departments.

• Assets inventoried, location does not match control group location — Lists asset records in the inventory file and control group with matching asset numbers but different locations/departments.

• Assets inventoried, not one of the control group assets — Lists asset records in the inventory file which have no records in the control group with matching asset numbers. Location/department is not considered and only valid asset numbers are included. Records in this group with invalid asset numbers are included in the exception report.

• Assets in the control group, not inventoried — Lists asset records in the control group which have no records in the inventory file with matching asset numbers.

 ➢ Creating an asset inventory

1. From the Administration page in Fixed Assets, click Asset Inventory. The Asset Inventory screen appears.

Mark Only show my asset inventories to display only assets inventories you created.
2. Click **New Inventory**. The New Asset Inventory screen appears on the General tab.

![New Asset Inventory Screen](image)

3. In the **Inventory Name** and **Description** fields, enter a name and description for the inventory.

4. In the **Date Completed** field, enter the date the inventory was completed.
5. In the **Inventory file name** field, enter the file path of the scanned inventory or click the ellipses to browse to the file’s location.

You must map the **Location/Department** and the **Asset Number/Asset ID/Serial Number** fields on the File Layout tab before you can process the file or create a pre-process report.

6. Select the File Layout tab. This tab is similar to the File Layout tab in **Import records**; however, you can use only delimited files.
7. In the **Field Separators and Text Qualifiers** frame, select the field separators and text qualifiers used in the import file. For example, in the **Field Separator** field, a comma may separate fields in a *.csv file. In the **Text qualifier** field, select a character, such as a quotation mark, to set off text that is imported into one field in the database.

If you select “Other” in the **Field separator** field or “Custom” in the **Text qualifier** field, enter the information in the corresponding text box.

8. In the **Inventory File Field Names** frame, specify whether your inventory file contains field names on the first line of the file or if the file does not contain field names.

9. The **Inventory File Field** column of the grid displays fields from the inventory file. You cannot edit this column.

10. In the **Asset Record Field** column of the grid, select the asset record fields to compare to the inventory file fields.

11. Select the Filters tab.
On the Filters tab you can select filters to designate the group of assets included in the inventory. If you do not select any filters, the control group of assets will contain all asset records except for disposed assets.

12. To include disposed assets in the control group, mark **Include disposed assets**.
13. Select the Attributes tab. On this tab, you can add, update, or delete attributes using a variety of qualities or characteristics created in Configuration. Attributes may include information relating an asset to a particular cost center, expense category, department, or program. For more information about adding attributes, see the Program Basics Guide.
14. Select the Notes tab. On this tab you can add notes about the asset inventory, such as participants, conditions, special circumstances, or actions taken. For more information about adding notes, see the Program Basics Guide.

![Notes Tab](image)

15. Select the Format tab.
16. In the **Include these inventory comparisons** box, you can select to include four report sections with various inventory comparisons. All report sections are included by default. Unmark the checkbox for any report section you do not want in the report. For more information about the report sections, see “Asset Inventory Reports” on page 49.

17. Mark **Subtotal by <location/department>** to sort and subtotal each of the four report sections by the control group location or department column.

18. To create an output query of assets in the control group not inventoried, mark the checkbox.

19. Before processing the file, you can click **Pre-Process Report** to review the changes to occur. When you are ready to process the file, close the report to return to the New Asset Inventory screen.

20. Click **Process File**. If you selected to create an output query of assets, the Create Static Query screen appears.

21. Enter a name in the **Query Name** field and click **Save**. The program begins processing.

22. When processing is complete, the Asset Inventory File Processed screen appears displaying the number of records processed and the number of exceptions.

   Records will not process successfully if:
   
   • Asset numbers are not valid.
   • Inventory file records do not contain a numeric field entry for the asset number.

The name for this checkbox depends on whether the inventory file contains departments or locations.
• Inventory file records do not contain an alphanumeric field entry for location or department.

• The inventory file contains duplicate asset numbers. If duplicates exist, the first will process and all others will be reported as exceptions.

23. From this screen, click View Control Report or Close.

24. If there are assets in the inventory with locations that do not match the system location, a message appears asking if you want to update the locations. Click Yes to update. The Update Locations screen appears listing all asset locations to update.

25. Click Update to continue. The Assets Updated screen appears listing the number of assets processed and the number of exceptions. Click View Control Report to identify any exceptions or click Close to return to the New Asset Inventory screen.

Student Billing Administration

Tasks that appear on the Administration page only in Student Billing include merging records, promoting students, managing billing groups, generating fixed amount automatic payments, automatically generated transactions, importing from a tuition management service, and creating financial aid schedules.

• “Globally Delete Transactions” on page 107

Status Wizards

The Status Wizards provide an efficient way for global or individual processing of applicant or student progression. To provide consistency, you can create and save multiple sets of parameters customized for your school.

If you have Admissions Office installed, you can access the Update Applications and Mark for Reenrollment wizards.

Updating Applications

With the Update Applications wizard, you can update the status information of applications. For example, you can accept or deny applicants.

If you have Admissions Office and Student Billing installed, you can use the Update Applications wizard to enroll applicants as students.

You can access the Updating Applications wizard from Administration, or from the applicant record.
Updating applications

1. From the Status Wizards page in Administration, select **Update Applications** and click **New**. The Update Applications Wizard appears.

2. In the **From school** field, select the school associated with the applications you want to update.

3. In the **Status** field, you can select an updated status for the application records.

4. In the **Status date** field, you can enter a date for the new status. In the **Status reason** field, you can enter a reason for the new status.

5. To update the **Grade apply** field on the applicant record, mark **Set grade apply**. You can choose to update the field based on a promotion schedule or enter the grade.

   If you choose “Based on promotion schedule”, select a promotion schedule in the **Promotion schedule** field. Enter a value in the **Grade apply if blank** field if you want to update blank **Grade apply** fields on the applications included in the process.

   If you choose “To value”, select a value in the **Grade apply** field. To overwrite the existing value, mark the **Overwrite existing grade apply** checkbox.

6. To update the **Current grade** field on the applicant record, mark **Set current grade**. You can update the current grade based on a promotion schedule or enter the grade value.

   If you choose “Based on promotion schedule”, select a promotion schedule in the **Promotion schedule** field. Enter a value in the **Current grade if blank** field if you want to update blank **Current grade** fields on the applications included in the process.
If you choose “To value”, select a value in the Current grade field. To overwrite the existing value, mark the Overwrite existing current grade checkbox.

7. To create a query of the applicant records that processed unsuccessfully and have an active application, mark Create exception query.

8. To create a query of the applicant records that are updated when you run the wizard, mark Create query of applicants with changes.

9. To print a report of the applicant records that are updated, mark Print a control report on and select a printer.

10. Click Next. The Additional Information tab appears.

11. In the Year apply field, select the academic year for which the applicant(s) is applying.

12. In the Term apply field, select the term for which the applicant(s) is applying.

13. In the Recruiter field, enter the applicant’s recruiter. You can click the binoculars to access a list of faculty/staff records.

14. In the Application date field, enter the date of the application.

15. In the Date accepted field, enter the date the application was accepted.

16. In the Date enrolled from field, enter the date the applicant will be enrolled in the school.

17. In the Grade enrolled field, select the grade level in which the applicant will be enrolled.

18. In the Class of field, enter the expected graduation year.

19. In the Board type field, select the type of boarding the student will need.

20. If you have only Admissions Office and Student Billing installed (no Registrar’s Office), the Enroll applicants as students checkbox appears. Mark this option to convert applicant records to student records.

![Checklist/Action tab](image)

22. In the **Delete** frame, you can mark **Tracks** or **Checklist items** to delete specified tracks and checklist items associated with the application.

23. In the **Add** frame, you can mark **Action** or **Tracks and checklist items** to add specified actions, tracks, and checklist items to the application.

   To add action information, click **Action Information**. To add tracks and checklist items, click **Checklist Item Information**. For more information about adding actions, tracks, and checklist items, see the *Records Guide for Admissions Office*.

24. Click Next. The Filters tab appears.

![Filters tab](image)
25. In the filters grid, you can filter the applicant information you want to process. For example, you can process one applicant or a group of applicants. For more information about filtering, see the Program Basics Guide.

26. To view a list of records included in the update, click Preview Included Records.

27. Click Preprocessing Report if you want to preview a report of changes to records before running the wizard.

28. Click Run Now to run the Update Applications wizard. The Save Update Applications Wizard as screen appears.

29. In the Name field, enter a name for your grouping of records. In the Description field, you can enter a description that will help you or other users identify the grouping later.

30. To allow other users to run or change the wizard with the parameters you have set up, mark Others can run or Others can modify.

31. Click Save to save your parameters. A confirmation message appears. Click Yes to run the wizard.

32. When the wizard is complete, a control report appears. Once you have reviewed the report, click the red X to return to the Update Application wizard.

33. Click Save and Close to return to the Status Wizards page.

Marking Students for Reenrollment

With the Mark for Reenrollment wizard, you can reenroll existing students and generate student progression entries to prepare them for the next year. Reenrollment includes students being promoted to a new school within the school system, but does not include students who are graduating out of the school system.

When you run the Mark for Reenrollment wizard, an applicant and application are enabled for students who have never been an applicant or have no application.

You can access the Mark for Reenrollment wizard from Administration or from the student record.
With the Mark for Reenrollment wizard, you can update and process multiple records at one time. We recommend creating a valid backup before running the wizard.

Security rights for the Status Wizards are set in Administration.

- **Marking students for reenrollment**

  Reenrollment includes students being promoted to a new school, but does not include students who are graduating out of the school system.

  1. From the Status Wizards page in Administration, select **Mark for Reenrollment** and click **New**. The Mark for Reenrollment Wizard appears.

  ![Mark for Reenrollment Wizard](image)

  2. In the **From school** field, select the school from which you are reenrolling the students. This field appears only if you have more than one active school.

  3. In the **Status** field, you can select a status for student records you are reenrolling.

  4. In the **Status date** field, you can enter the current date of the status.

  5. In the **Status reason** field, you can enter a reason for the current status.

  6. In the **To year** field, select the year to which you are reenrolling the students. You can select “This academic year” or “Next academic year.”

  7. To create a query of the student records that processed unsuccessfully, mark **Create exception query**.

    Records that receive warnings are not included the exception query. A warning indicates that the record processed successfully but might have something that did not get updated, such as the student progression entry or the prefix.

  8. To create a query of the student records that are updated when you run the wizard, mark **Create query of students with changes**.

  9. To print a report of the student records that are updated, mark **Print a control report on** and select a printer.
10. Click Next. The Additional Information tab appears.

11. In the Date enrolled from field, enter the date the student will be reenrolled in the school.
   If you select “Today” in the Date enrolled from field and save the parameters to run this wizard again, you do not have to update this field each time you run the saved wizard.

12. In the Grade enrolled field, select the grade level for which the student is being reenrolled.

13. In the Class of field, enter the expected graduation year.

14. In the Board type field, select the type of boarding the student will need.
15. Click Next. The Checklist tab appears.

16. In the Delete frame, you can mark Tracks or Checklist items to delete specified tracks and checklist items associated with the applicant record(s).

17. In the Add frame, you can mark Tracks and checklist items to add specified tracks and checklist items to the student/applicant record(s).

To add track and checklist items to the applicant, click Checklist Item Information. For more information about adding tracks and checklist items, see the Records Guide for Admissions Office.

18. Click Next. The Attributes tab appears.

When you run the Mark for Reenrollment wizard, an applicant and application is enabled for students who have never been an applicant or have no application.
19. In the first grid, you can select attributes to copy from the student side of the record to the applicant side of the record. For a student attribute to copy to the applicant side of the record in Admissions Office, the attribute must also be defined as an applicant attribute in Configuration in Admissions Office.

- In the Attribute Type column, select the attribute to add or update on the applicant side of the record.

- In the Overwrite Existing? column, mark the checkbox to overwrite the existing value for the attribute if the applicant side of the record already exists and contains the attribute.

If the attribute is defined as unique (can be used only once on a record) and you do not mark Overwrite Existing?, the attribute is not copied and generates an exception. If the attribute already exists on the applicant side of the record, but is not defined as unique and you mark Overwrite Existing?, a new instance of the attribute is copied but the original is not overwritten.

20. In the Please provide values for the Admissions Office applicant required attributes, you enter values for required applicant attributes. You can also add additional attributes to applicant records by selecting attributes in the Attribute Type column.

- In the Description column, select or enter a description of the attribute.

- In the Date column, enter a date to record when you add the attribute.

- If this attribute type is required on an applicant record, the program automatically marks the checkbox in the Required column. You cannot edit this column.

- In the Comments column, enter any additional comments or more detailed information about the attribute. You can enter free-form text in this column.

If you are copying a required attribute from the student side of the record to the applicant side, the copied value is used instead.

If a required value is already on the applicant side of the record, and the attribute is defined as unique, the attribute is not copied and generates an exception. If the attribute is not defined as unique, a new instance of the attribute is copied but the original is not overwritten.
21. Click Next. The Filters tab appears.

22. In the filters grid, you can filter the student information you want to process. For example, you can reenroll one student or a group of students. For more information about filtering, see the Program Basics Guide.

23. To view a list of records included in the update, on the action bar click **Preview Included Records**.

24. Click **Preprocessing Report** if you want to preview a report of changes to records before running the wizard.

25. Click **Run Now** to run the Mark for Reenrollment wizard. The Save Mark for Reenrollment Wizard as screen appears.

26. In the **Name** field, enter a name for your grouping of records. In the **Description** field, enter a description that will help you or other users identify the grouping later.

27. To allow other users to run or change the wizard with the parameters you have set up, mark **Others can run** or **Others can modify**.

28. Click **Save** to save your parameters. A confirmation message appears. Click **Yes** to run the wizard.

To provide consistency, you can create and save multiple sets of parameters to use when you run a wizard.
29. When the wizard is complete, a control report appears. Once you have reviewed the report, click the red X to return to the Mark for Reenrollment wizard.

30. Click Save and Close to return to the Status Wizards page.

Adding, Copying, and Deleting Bill Codes

Using the Add, Copy, or Delete bill codes link in Administration, you can quickly add new bill codes or copy or delete existing ones for a selected group of records.

If you generated transactions based on bill codes on records, we recommend that you do not delete these from student records so you have a record for historical information and troubleshooting purposes.

➤ Globally add bill codes

1. In the Action field, select “Add Bill Codes” to globally add bill codes to a group of records.

2. In the Query name field, browse to the query containing the records you want to add bill codes to.

3. In the Bill Code field, select the bill code to add.

4. In the Billing Cycle field, define the start and end dates of the bill codes you are adding. Select a billing cycle or “<Specific Dates>” to define a date range in the From and To fields.

5. To print a control report of the bill codes added, mark Print control report.

6. To create a query of records the program cannot add the bill codes to, mark Create an exception query.

7. To review the changes before processing, click Preprocessing report. This report also lists any exceptions.

8. Click Add Now. The process run and then a completion screen appears listing the number of bill codes processed, added, and the exceptions.

9. Click Close to return to the Administration page.

➤ Globally copy bill codes

1. In the Action field, select “Copy Bill Codes” to globally copy bill codes from a group of records.

2. In the Query name field, browse to the query containing the records you want to copy bill codes from.
3. Bill codes that fall within the specified date range are copied. In the **Copy bill codes from** field, select “<Specific date>” to enter a date in the **Ending on** field. The program copies bill codes that end on the date entered. The starting date for the bill code copied to the record is the first date after the date entered in the **Ending on** field. The copied bill code ends in the same increment of days as the one being copied from. For example, if start date for the bill code being copied from is 8/1/08 and the ending date is 8/1/09, the starting date for the bill code copied to the record is 8/2/09 and the ending date is 8/2/10.

If you use billing cycles, select a billing cycle to copy from in the **Copy bill codes from** field and select the billing cycle you want to copy the bill code to in the **to** field.

4. Select the bill codes to copy by moving bill code descriptions in the left box to the right using the arrow buttons.

5. To print a control report of the bill codes copied, mark **Print control report**.

6. To create a query of records the program cannot copy the bill codes from, mark **Create an exception query**.

7. To review the changes before processing, click **Preprocessing report**. This report also lists any exceptions.

8. Click **Copy Now**. The process run and then a completion screen appears listing the number of bill codes processed, copied, and the exceptions.

9. Click **Close** to return to the Administration page.

➢ **Globally delete bill codes**

1. In the **Action** field, select “Delete Bill Codes” to globally delete bill codes from a group of records.

2. In the **Query name** field, browse to the query containing the records you want to delete bill codes from.

3. In the **For** field, select a billing cycle, “<All Dates>, or “<Specific dates>” option. If you select “<Specific Dates>”, you can define a date range in the **From** and **To** fields. Bill codes that fall into the specified period of time will be deleted.

4. Select the type of bill codes to delete by moving bill code descriptions in the left box to the right using the arrow buttons.

5. To print a control report of the bill codes deleted, mark **Print control report**.

6. To create a query of records the program cannot delete bill codes from, mark **Create an exception query**.

7. To review the changes before processing, click **Preprocessing report**. This report also lists any exceptions.

8. Click **Delete Now**. The process run and then a completion screen appears listing the number of bill codes processed, deleted, and the exceptions.

9. Click **Close** to return to the Administration page.
Merge Process

The merge process moves information from the duplicate faculty/staff, individual, organization, applicant, and student records, to the primary records.

If you integrated Admissions Office and Registrar’s Office with Student Billing, you can merge the records converted from Student Billing with records in The Education Edge. This utility merges records that match based on the duplicate criteria you define, such as last name, first name, and address. The result is a single record that contains a combination of information from both records.

Merge Considerations

Before running the merge utility, you should review the following information and recommendations:

• Each time you run the merge utility, we recommend you make a valid backup of the database. Large amounts of data are being manipulated during this process, and without a backup, correcting the data could be difficult. You can recover merged records only by restoring to a backup.

• The amount of time it takes to run the merge utility will vary depending on your hardware and how many records you are merging.

• If you are trying to merge a large number of records, you should run the merge utility multiple times using different duplicate criteria.

• To ensure that applicant and student relation information merges successfully, we recommend you merge applicant and student records before merging individual and faculty/staff records.

• We recommend you merge duplicate records instead of deleting one of them so you do not lose any information.

• If you have saved merge parameter files, we recommend you review and validate the accuracy of your parameter files before merging. You should save any parameter files you create for future reference.

• If you previously used Academy Manager to integrate these programs in version 6 before converting to version 7, we recommend you first run the merge utility using Academy ID as the criteria. Then run again using name and address as the criteria.

• The Education Edge and Student Billing security is set up separately, even for shared records. However, delete functionality is allowed only if a user has access to delete in both programs.

• You can merge multiple records at one time, however, we recommend running merge in groups.

• If you want to merge a student and individual, or applicant and individual, the individual will need to be converted first.

• When merging faculty and individual records, if the individual record has attributes which are not set up in Configuration for faculty records, the attributes for the individual record will be deleted during the merge process. To ensure these attributes are not deleted, the same attributes must exist on the faculty record prior to merging.
• When you integrate Admissions Office and Registrar’s Office with Student Billing, all the new student records will have an active billing status if you selected “Active” for the When an applicant is enrolled or a new student is created in Education Edge, default billing status to [ ] business rule in Student Billing. This is why the Keep billing status from the duplicate record option on the merge parameter form is very important.

• If records created by the Student Billing conversion need to be designated primary because the data is more up to date, you need to consider that the Current status created for those records for Registrar’s Office are just a default and do not reflect the appropriate current status. This is why the Keep current status from the duplicate record option on the merge parameter form is very important.

• Not merging duplicate records can be a form of data corruption. For example, in an integrated system, you might have two records per student in your database. Changes that users make to one record, such as phone number and address updates, will not be reflected on the other record. Therefore, Registrar’s Office users and Student Billing users will not view the same information when accessing a record.

Merging Records

The merge utility is available from the Administration page of Admissions Office, Registrar’s Office and Student Billing as a tool for ongoing duplicate identification and merging.

Before merging records, we recommend you review the Integration Planning Checklist located in the Integrating Student Billing with The Education Edge guide, as well as “Merge Considerations” on page 70.

➢ Merging records

1. From the Administration page, click Merge Records.
2. To create a new merge, click New on the action bar. The Merge Records screen appears.

![Merge Records screen](image)

3. In the **Merge using** field, select “specified criteria” or “specific records”. If you select “specified criteria”, you can enter duplicate criteria and review duplicate records based on that criteria before merging them into primary records. We recommend you select this option.

If you select “specific records”, you manually select the primary records and the duplicate records to merge into the primary records on the Preview tab.

4. In the **Merge records within these record types** box, mark the record types you want to merge. For example, to search only for duplicate student records, only mark the **Students** checkbox.

If you are merging students and want to include applicants in the duplicate checking, mark **Include students when checking for duplicates**.

5. If you selected “specified criteria” in the **Merge using** field, you must select duplicate criteria in the grid for each selected record type. In the **Field Name** column, select the fields to use in the duplicate search. In the **Length** column, enter the number of characters to check in each field during the duplicate search.

When selecting duplicate criteria, please keep the following issues in mind:

- When including “Academy ID” as criteria, Academy IDs that are zero or blank are ignored.

- If you converted a record with an ID or SSN matching one already in the database, the duplicate ID or SSN was stored as an attribute instead. So if you are including ID or SSN as criteria, the program also checks for attributes with these values.
You must have the appropriate security rights to merge records based on Social Security numbers. For more information, see the Security chapter of the Administration Guide for The Financial Edge.

- On certain record types, you can also mark an additional checkbox to check for duplicates in other record types. In applicant criteria, you can select to include student records. In faculty/staff criteria, you can select to include individual records. In student criteria, you can select to include applicant records.

- Make sure you are choosing fields that were used the same across offices.

6. In the **when resolving a conflict between the records being merged use** field, select which record to use when merging records containing different values.

   - If you select “date last changed”, the program considers the record with the latest date last changed value as the primary record. We recommend you do not select this option if merging after conversion. If you are merging records after converting, be aware that the date last changed for the records is the conversion date.

   - If you select “the record with the attribute added by the Student Billing conversion”, the program considers the record converted from Student Billing 6 to Student Billing 7 as the primary record. If no records have this attribute or multiple records have this attribute, the program uses the one with the latest date last changed value as the primary record. Select this option if you want the student record coming from Student Billing as the primary record.

   - If you select “the record without the attribute added by the Student Billing conversion”, the program considers the record not converted from Student Billing 6 to Student Billing 7 as the primary record (if there are two records, one with the attribute and one without). Select this option if you do not want the student record coming from Student Billing to be the primary record.

7. Mark **keep billing status from the duplicate record** if you want to overwrite the billing status on the primary record with the billing status from the duplicate record. This is especially important when first merging Student Billing 7 and Admissions Office/Registrar’s Office 7 records together when Student Billing 7 records are selected as the duplicate record.

8. Mark **keep current status from the duplicate record** if you want to overwrite the current status on the primary record with the current status from the duplicate record. This is especially important when first merging Student Billing 7 and Admissions Office/Registrar’s Office 7 records together when Admissions Office/Registrar’s Office 7 records are selected as the duplicate record.

9. To create an output query of merged records included in the processing, mark **create an output query of merged records**.

We recommend using the merge utility as a tool for ongoing duplicate record identification and merging.
10. Select the Filters tab to further filter the included records. This tab is only available if you choose to merge using specified criteria.

11. Set the filters you want for the records included in the merge.

12. Select the Addresses tab to establish criteria for how to compare addresses on the records you are merging.

When comparing address lines, the program ignores punctuation and uses address abbreviation equivalents to search for addresses that are the same but may be punctuated or abbreviated differently. For details, see “Comparing Addresses” on page 78.

13. In the **When merging addresses, check the following fields for identical values** box, mark checkboxes for the address fields to check for duplicates. This helps the program determine which addresses on the duplicate record already exist on the primary record.
If you want the addresses to merge even if the address type is different and everything else is identical, unmark **Address type**.

14. If you selected to check address lines, in **Use [ ] characters of the address lines**, enter the number of characters to check in the address lines for duplicates.

15. If you selected to check the ZIP/postcode, in the **Use [ ] characters of the ZIP/postcode**, enter the number of characters to check in the ZIP/postcode for duplicates.

16. Select the Preview tab to view the records the program considers duplicates based on your criteria.
17. The records listed are considered the primary records. To expand all of the rows for the records, click **Expand All** on the action bar. The rows under a primary record are considered the duplicate records that will be merged with the primary record.

18. Review the duplicate records found to determine if they look like duplicates or if you need to adjust your criteria. For example, if many duplicate records appear for one primary record, you probably need to adjust your criteria.

   - To help with reviewing duplicate records, you can include columns for your criteria in the grid. Right-click the grid and select **Columns** to control the columns that appear.
   - To review a record, select the row and click **Open** on the action bar.
   - If there is more than one duplicate record for a primary record, the order of the duplicate records under the primary record determines which duplicate record’s data is used first if a field is blank on the primary record. Put the most accurate duplicate record first in order. You can use the **Up** and **Down** buttons to rearrange the rows.

19. If you do not want to merge a record, unmark the checkbox in the **Merge?** column for the record.
20. If you selected “specific records” in the Merge using field on the General tab, select the Preview tab to select the primary records along with the duplicate records to merge.

21. To enter a primary record, click Load Primary Record on the action bar to search for and select a record.

22. To enter a duplicate record to merge into a primary record, search for and select the record in a row below the primary record. To add a row, you can select the row of the primary record and click Insert Duplicate on the action bar.

If there is more than one duplicate record for a primary record, the order of the duplicate records under the primary record determines which duplicate record’s data is used first if a field is blank on the primary record. Put the most accurate duplicate record first in order. You can use the Up and Down buttons to rearrange the rows.
23. To omit a record from the merge, unmark the checkbox in the Merge? column.

24. When you are ready to begin the merge, click Merge.

25. When the merge is complete, the Merge Records Complete screen appears, displaying statistics about the processing.

26. Click Close. The control report appears with more detail about the processing.

**Comparing Addresses**

When comparing addresses, the program ignores punctuation and uses address abbreviation equivalents to search for addresses that are the same but may be punctuated or abbreviated differently.

**Punctuation**

The following punctuation is ignored in the address text fields when searching for duplicate addresses:

- Hyphen
- Colon
- Apostrophe
- Period
- Semicolon
- Parenthesis
- Carriage return/line feed

This punctuation is also ignored in phone types with a phone number type of Telephone Number, Fax Number, or Other, but not in phone types with a phone number type of Email Address or Web Address/URL.

**Address Abbreviation Equivalents**

This table lists the address abbreviation equivalents the program uses when comparing address lines.

<table>
<thead>
<tr>
<th>Address</th>
<th>Equivalent</th>
</tr>
</thead>
<tbody>
<tr>
<td>Annex</td>
<td>Anx</td>
</tr>
<tr>
<td>Apartment</td>
<td>Apt</td>
</tr>
<tr>
<td>Arcade</td>
<td>Arc</td>
</tr>
<tr>
<td>Avenue</td>
<td>Ave</td>
</tr>
<tr>
<td>Bayou</td>
<td>Byu</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Address</th>
<th>Equivalent</th>
</tr>
</thead>
<tbody>
<tr>
<td>Freeway</td>
<td>Fwy</td>
</tr>
<tr>
<td>Gardens</td>
<td>Gdns</td>
</tr>
<tr>
<td>Gateway</td>
<td>Gtwy</td>
</tr>
<tr>
<td>Glen</td>
<td>Gln</td>
</tr>
<tr>
<td>Green</td>
<td>Grn</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Address</th>
<th>Equivalent</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rest</td>
<td>Rst</td>
</tr>
<tr>
<td>Ridge</td>
<td>Rdg</td>
</tr>
<tr>
<td>River</td>
<td>Riv</td>
</tr>
<tr>
<td>Road</td>
<td>Rd</td>
</tr>
<tr>
<td>Shoal</td>
<td>Shl</td>
</tr>
<tr>
<td>Address</td>
<td>Equivalent</td>
</tr>
<tr>
<td>-----------</td>
<td>------------</td>
</tr>
<tr>
<td>Beach</td>
<td>Bch</td>
</tr>
<tr>
<td>Bend</td>
<td>Bod</td>
</tr>
<tr>
<td>Bluff</td>
<td>Blf</td>
</tr>
<tr>
<td>Bottom</td>
<td>Btm</td>
</tr>
<tr>
<td>Boulevard</td>
<td>Blvd</td>
</tr>
<tr>
<td>Branch</td>
<td>Br</td>
</tr>
<tr>
<td>Bridge</td>
<td>Brg</td>
</tr>
<tr>
<td>Brook</td>
<td>Brk</td>
</tr>
<tr>
<td>Burg</td>
<td>Bg</td>
</tr>
<tr>
<td>Bypass</td>
<td>Byp</td>
</tr>
<tr>
<td>Camp</td>
<td>Cp</td>
</tr>
<tr>
<td>Canyon</td>
<td>Cyn</td>
</tr>
<tr>
<td>Cape</td>
<td>Cpe</td>
</tr>
<tr>
<td>Causeway</td>
<td>Cswy</td>
</tr>
<tr>
<td>Center</td>
<td>Ctr</td>
</tr>
<tr>
<td>Circle</td>
<td>Cir</td>
</tr>
<tr>
<td>Cliffs</td>
<td>Clfs</td>
</tr>
<tr>
<td>Club</td>
<td>Clb</td>
</tr>
<tr>
<td>Corner</td>
<td>Cor</td>
</tr>
<tr>
<td>Corners</td>
<td>Cors</td>
</tr>
<tr>
<td>Course</td>
<td>Crse</td>
</tr>
<tr>
<td>Court</td>
<td>Ct</td>
</tr>
<tr>
<td>Courts</td>
<td>Cts</td>
</tr>
<tr>
<td>Cove</td>
<td>Cv</td>
</tr>
<tr>
<td>Creek</td>
<td>Crk</td>
</tr>
<tr>
<td>Crescent</td>
<td>Cres</td>
</tr>
<tr>
<td>Crossing</td>
<td>Xing</td>
</tr>
<tr>
<td>Dale</td>
<td>Di</td>
</tr>
<tr>
<td>Dam</td>
<td>Dm</td>
</tr>
<tr>
<td>Divide</td>
<td>Dv</td>
</tr>
<tr>
<td>Drive</td>
<td>Dr</td>
</tr>
<tr>
<td>Estates</td>
<td>Est</td>
</tr>
<tr>
<td>Expressway</td>
<td>Expy</td>
</tr>
</tbody>
</table>
CHAPTER 1

How Information on Duplicate Records Merges with the Primary Record

This table provides information about how data on duplicate records merges with data on the primary record.

<table>
<thead>
<tr>
<th>Information</th>
<th>Record Type</th>
<th>What happens?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bio 1</td>
<td>All person records</td>
<td>Copies information if on duplicate but not on primary, but does not replace existing data.</td>
</tr>
<tr>
<td>Bio 2 / Birth Information</td>
<td>Applicant/Student - all views</td>
<td>Copies information if on duplicate but not on primary, but does not replace existing data.</td>
</tr>
<tr>
<td>Bio 2 / Billing Information and Billing Defaults</td>
<td>Student in Student Billing</td>
<td>Copies information if on duplicate but not on primary, but does not replace existing data.</td>
</tr>
<tr>
<td>Bio 2 / In-state Resident and Recruiting Information</td>
<td>Applicant in Admissions Office</td>
<td>Copies information if on duplicate but not on primary, but does not replace existing data.</td>
</tr>
<tr>
<td>Bio 2 / Other Schools Applied To</td>
<td>Applicant in Admissions Office</td>
<td>Entries on duplicates are added to primary (though only one can have the Attending checkbox marked).</td>
</tr>
<tr>
<td>Information</td>
<td>Record Type</td>
<td>What happens?</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>-------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Bio 2 / Dormitory, Phone number, Roommate, Room, and Transportation</td>
<td>Student in Registrar’s Office</td>
<td>Copies information if on duplicate but not on primary, but does not replace existing data.</td>
</tr>
<tr>
<td>Bio 2 / Lockers and Cars</td>
<td>Student in Registrar’s Office</td>
<td>Entries on duplicates are added to primary.</td>
</tr>
<tr>
<td>Bio 2 / Date hired, Terminated on, Reason</td>
<td>Faculty/Staff</td>
<td>Copies information if on duplicate but not on primary, but does not replace existing data.</td>
</tr>
<tr>
<td>Bio 2 / Department/Position, Education, Certifications</td>
<td>Faculty/Staff</td>
<td>Any entries on duplicate but not on primary are added.</td>
</tr>
<tr>
<td>Visa/Passport</td>
<td>Applicant/Student - Admissions Office and Registrar’s Office views, Faculty/Staff</td>
<td>Copies information if on duplicate but not on primary, but does not replace existing data.</td>
</tr>
<tr>
<td>Demographics</td>
<td>Applicant/Student - all views, Faculty/Staff, Individuals</td>
<td>Copies information if on duplicate but not on primary, but does not replace existing data.</td>
</tr>
<tr>
<td>Photo</td>
<td>Applicant/Student - all views Faculty/Staff, Individuals</td>
<td>Copies information if on duplicate but not on primary, but does not replace existing data.</td>
</tr>
<tr>
<td>Primary address</td>
<td>All records</td>
<td>A record must have a primary address. If primary record does not have a primary address, the primary address from a duplicate record will be added. If an address matches on the duplicate and primary records, but there are contacts on the duplicate record that are not on the primary record, the contacts are added to the address on the primary record. However, if a contact type is already in use on the primary record, the contact number for that contact type will only be copied from the duplicate if the contact number on the primary is blank.</td>
</tr>
<tr>
<td>Information</td>
<td>Record Type</td>
<td>What happens?</td>
</tr>
<tr>
<td>------------------------------</td>
<td>----------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Additional addresses</td>
<td>All records</td>
<td>Any entries on duplicate but not on primary are added.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If an address matches on the duplicate and primary records, but the address on the duplicate record is linked to records not linked to on primary record, the links are added to the address on the primary record.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If an address matches on the duplicate and primary records, but there are contacts on the duplicate record that are not on the primary record, the contacts are added to the address on the primary record. However, if a contact type is already in use on the primary record, the contact number for that contact type will only be copied from the duplicate if the contact number on the primary is blank.</td>
</tr>
<tr>
<td>Primary addressee and Primary salutation</td>
<td>All person records</td>
<td>If primary record does not have a primary addressee or salutation, the primary addressee or salutation from a duplicate record will be added.</td>
</tr>
<tr>
<td>Additional addresses and salutations</td>
<td>All person records</td>
<td>Any entries on duplicate but not on primary are added.</td>
</tr>
<tr>
<td>Attributes</td>
<td>All records</td>
<td>Entries on duplicates are added to primary.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If a unique attribute exists on the primary record, attributes from the same category on the duplicate record cannot be added.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>For applicant/students, merging is specific to each view: applicant view in Admissions Office, student view in Registrar’s Office, and student view in Student Billing.</td>
</tr>
<tr>
<td>Information</td>
<td>Record Type</td>
<td>What happens?</td>
</tr>
<tr>
<td>------------------</td>
<td>----------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Notes</td>
<td>All records</td>
<td>Entries on duplicates are added to primary. For applicant/students, merging is specific to each view: applicant view in <em>Admissions Office</em>, student view in <em>Registrar’s Office</em>, and student view in <em>Student Billing</em>.</td>
</tr>
<tr>
<td>Actions</td>
<td>All records</td>
<td>Entries on duplicates are added to primary. For applicant/students, merging is specific to each view: applicant view in <em>Admissions Office</em>, student view in <em>Registrar’s Office</em>, and student view in <em>Student Billing</em>.</td>
</tr>
<tr>
<td>Media</td>
<td>All person records</td>
<td>Entries on duplicates are added to primary. For applicant/students, merging is specific to each view: applicant view in <em>Admissions Office</em>, student view in <em>Registrar’s Office</em>, and student view in <em>Student Billing</em>.</td>
</tr>
<tr>
<td>Financial Aid</td>
<td>Applicant/Student - all views</td>
<td>Any entries on duplicate but not on primary are added. If the same academic year exists on both, information from the duplicate is added if it does not exist on the primary.</td>
</tr>
<tr>
<td>History of Changes</td>
<td>All records</td>
<td>An entry is generated only when information is added to key fields on the primary record.</td>
</tr>
<tr>
<td>Relationships</td>
<td>All records</td>
<td>Any entries on duplicate but not on primary are added. If the same relationship exists on both, information from the duplicate is added if it does not exist on the primary.</td>
</tr>
<tr>
<td>Activities</td>
<td>Student in <em>Student Billing</em></td>
<td>Entries on duplicates are added to primary.</td>
</tr>
<tr>
<td>Information</td>
<td>Record Type</td>
<td>What happens?</td>
</tr>
<tr>
<td>-------------------</td>
<td>-------------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Annotations</td>
<td>Student in <em>Student Billing</em></td>
<td>Any entries on duplicate but not on primary are added.</td>
</tr>
<tr>
<td>Exceptions on Payers</td>
<td>Student in <em>Student Billing</em></td>
<td>Any entries on duplicate but not on primary are added.</td>
</tr>
<tr>
<td>Statements</td>
<td>Student in <em>Student Billing</em></td>
<td>Any entries on duplicate but not on primary are added.</td>
</tr>
<tr>
<td>Bill Codes</td>
<td>Student in <em>Student Billing</em></td>
<td>Any entries on duplicate but not on primary are added.</td>
</tr>
<tr>
<td>EFT Bank Information</td>
<td>Student in <em>Student Billing</em></td>
<td>Any entries on duplicate but not on primary are added.</td>
</tr>
<tr>
<td>Default Schedules</td>
<td>Student in <em>Student Billing</em></td>
<td>Any entries on duplicate but not on primary are added.</td>
</tr>
<tr>
<td>Automatic Payments</td>
<td>Student in <em>Student Billing</em></td>
<td>Entries on duplicates are added to primary.</td>
</tr>
<tr>
<td>Student Progression</td>
<td>Student in <em>Student Billing</em></td>
<td>Any entries on duplicate but not on primary are added.</td>
</tr>
<tr>
<td>Education</td>
<td>Applicant/Student in <em>Admissions Office</em> and <em>Registrar’s Office</em></td>
<td>Any entries on duplicate but not on primary are added.</td>
</tr>
<tr>
<td>Tests</td>
<td>Applicant/Student in <em>Admissions Office</em> and <em>Registrar’s Office</em></td>
<td>Any entries on duplicate but not on primary are added.</td>
</tr>
<tr>
<td>Medical</td>
<td>Applicant/Student in <em>Admissions Office</em> and <em>Registrar’s Office</em></td>
<td>Any entries on duplicate but not on primary are added.</td>
</tr>
<tr>
<td>Activities</td>
<td>Applicant/Student in <em>Admissions Office</em> and <em>Registrar’s Office</em></td>
<td>Any entries on duplicate but not on primary are added.</td>
</tr>
<tr>
<td>Conduct</td>
<td>Student in <em>Registrar’s Office</em></td>
<td>Any entries on duplicate but not on primary are added.</td>
</tr>
<tr>
<td>Applications</td>
<td>Applicant in <em>Admissions Office</em></td>
<td>Any entries on duplicate but not on primary are added.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If an entry matches on the duplicate and primary based on Year Apply, information from the duplicate entry is added if it does not exist on the primary entry.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>An applicant view can be created for a primary record if the School and Current Status of an application on the duplicate matches an enrollment on the primary.</td>
</tr>
<tr>
<td>Information</td>
<td>Record Type</td>
<td>What happens?</td>
</tr>
<tr>
<td>----------------------</td>
<td>------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Enrollments</td>
<td>Student in Registrar’s Office</td>
<td>Any entries on duplicate but not on primary are added.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If an entry matches on the duplicate and primary based on School and Grade Enrolled, information from the duplicate entry is added if it does not exist on the primary entry.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>A student view can be created for a primary record if the School and Current Status of an enrollment on the duplicate matches an application on the primary.</td>
</tr>
<tr>
<td>Schedule Changes</td>
<td>Student in Registrar’s Office</td>
<td>Any entries on duplicate but not on primary are NOT added.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Changes can be recorded when enrollments are added to a primary record during merge.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If a class is added to the primary record and a change is recorded, Changed On and Changed By will display the date of the merge and the user who ran the merge. You may want to note the original date and user who added the class on the duplicate record in the Comments column of the Schedule Changes screen.</td>
</tr>
<tr>
<td>Status Log</td>
<td>Applicant/Student in</td>
<td>Any entries on duplicate but not on primary are added (only when application or enrollment is added).</td>
</tr>
<tr>
<td></td>
<td>Admissions Office and</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Registrar’s Office</td>
<td></td>
</tr>
<tr>
<td>Course Requests</td>
<td>Student in Registrar’s Office</td>
<td>Any entries on duplicate but not on primary are added.</td>
</tr>
<tr>
<td>Schedule</td>
<td>Student and Faculty/Staff in</td>
<td>Any entries on duplicate but not on primary are added.</td>
</tr>
<tr>
<td></td>
<td>Registrar’s Office</td>
<td></td>
</tr>
<tr>
<td>Grades</td>
<td>Student in Registrar’s Office</td>
<td>Any entries on duplicate but not on primary are added.</td>
</tr>
<tr>
<td>Attendance</td>
<td>Student in Registrar’s Office</td>
<td>Any entries on duplicate but not on primary are added.</td>
</tr>
<tr>
<td>Checklist Items</td>
<td>Applicant in Admissions</td>
<td>Any entries on duplicate but not on primary are added.</td>
</tr>
<tr>
<td></td>
<td>Office</td>
<td></td>
</tr>
</tbody>
</table>
CHAPTER 1

Promoting Students

If you have Registrar’s Office, you promote students using the End of Year Processing wizard. For more information about the End of Year Processing wizard, see the Administration Guide for The Education Edge.

If you do not have Registrar’s Office, you promote students through Administration in Student Billing. By promoting students, you advance selected students to a new grade and you can also process graduating students.

<table>
<thead>
<tr>
<th>Information</th>
<th>Record Type</th>
<th>What happens?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Conduct</td>
<td>Faculty/Staff in Registrar’s Office</td>
<td>Entries on duplicates are added to primary.</td>
</tr>
<tr>
<td>Courses</td>
<td>Faculty/Staff in Registrar’s Office</td>
<td>Any entries on duplicate but not on primary are added.</td>
</tr>
<tr>
<td>Restrictions</td>
<td>Faculty/Staff in Registrar’s Office</td>
<td>Any entries on duplicate but not on primary are added.</td>
</tr>
<tr>
<td>Faculty/staff information for Faculty Access for the Web</td>
<td>Faculty/Staff in Registrar’s Office</td>
<td>Any entries on duplicate but not on primary are added.</td>
</tr>
<tr>
<td>Integration links with Raiser’s Edge records</td>
<td>All records mapped for integration</td>
<td>The link of the primary record is maintained, along with the address and relationship links. However, if a primary record does not have a link, but a duplicate record does, the link from the duplicate is copied to the primary.</td>
</tr>
</tbody>
</table>
Promoting students

1. From the Administration page in Student Billing, click Promote students. The Promote Students screen appears.

2. In the Billing status field, select a billing status to use for returning students.

3. To update the records of students who have graduated, mark Upgrade graduating students. In the fields below, select a billing status, enrollment status, graduation date, date enrolled to date, and reason left for the graduating students. To update the Grade left field to the grade of the student before graduating, mark Update grade left.

4. To create a query of students not included in the processing, mark Create exception query of students.

5. To create a query of students included in the processing, mark Create output query of students.

6. To print a control report, mark Print control report on and select a printer.
7. Select the Filters tab.

![Filters Tab Image]

- Bill codes selected must apply to the current date to be included.

8. You can filter the records included in the processing. For more information about filtering criteria, see the Program Basics Guide.

9. Select the Attributes tab.

![Attributes Tab Image]

10. In the Action column, you can select to add, update, or delete attributes for students when you promote them.
11. In the **Attribute Type** column, select an attribute type.

12. In the **Description** column, enter or select a description for the attribute type.

   If you selected a table type attribute that uses short descriptions, you select the attribute description in the **Short Description** column. The **Description** column completes automatically.

13. In the **Date** column, enter the date you add the attribute or another date relevant to the attribute.

14. If the attribute is required, the checkbox is marked in the **Required** column.

15. In the **Comments** column, enter any additional information about the attribute.

16. Select the Preview tab.

17. Unmark the checkbox in the **Promote?** column for any students you do not want to promote.

18. To review the changes before processing, click **Preprocessing Report**.

19. Once you have reviewed the preprocessing report and are ready to promote the students, click **Process Now**.
20. When processing is complete, the Promote Students Complete screen appears, displaying statistics about the processing.

![Promote Students Complete screenshot]

21. Click Close. The control report appears with more detail about the processing.

Managing Billing Groups

With billing groups, you can quickly add or update student, individual, or organization records. You can also use this feature to create links and relationships among associated records. For example, you can add records for an entire family at one time. You can link these records and copy address and billing information from one record to all the others.

You can also manage billing groups from the Students, Individuals, or Organizations page in Records. For more information about records, see the Records Guide for Student Billing.

- Adding a record using Manage Billing Groups

  1. From the Administration page in Student Billing, click Manage billing groups. The Manage Billing Groups screen appears.

![Manage Billing Groups screenshot]
2. From the dropdown, you can select Add New Student, Add New Individual, or Add New Organization. For this procedure, we will add a new individual. The procedure is similar for students and organizations.

3. After clicking Add New Individual, “New Individual” appears in the Records box on the left and you can enter biographical information in the fields that appear on the right.

4. Select the Defaults tab.

5. Click Billing Defaults to add billing defaults.
6. Click **Relationships** to add relationships.

7. Select the Addresses tab. On this tab, you can add address and contact information for the individual.

When you click **Finish and New** or **Finish and Close**, a completion screen appears listing the number of new records created and the number updated.

8. When you finish making changes, you can:
   - Click **Finish and New** to save and close the individual record and open a new billing group automatically.
   - Click **Finish and Close** to save and close the individual record and return to the Administration page.
Updating an existing record using Manage Billing Groups

You can add or update a single record using Manage Billing Groups. Though this procedure is for individual records, the procedure is similar for student and organization records.

1. From the Administration page in Student Billing, click Manage billing groups. The Manage Billing Groups screen appears.

2. In the Record Name field, enter the individual name or click the binoculars to locate the individual record to update.

3. Click the down arrow next to Load all associated records and select “Load only selected record”. Biographical information for the individual appears.
When you add or update a record using 
Manage Billing Groups, 
changes are not saved until 
you click Finish and New or Finish and Close.

4. You can add or make changes to biographical information.
5. Select the Defaults tab.
6. Click **Billing Defaults** to view or edit billing defaults.

7. Click **Relationships** to view or edit relationships.
8. Select the Addresses tab. On this tab, you can view, edit, or add new addresses for the individual.

![Manage Billing Groups](image)

9. When you finish making changes, you can:
   - Click **Finish and New** to save and close the individual record and open a new billing group automatically.
   - Click **Finish and Close** to save and close the individual record and return to the Administration page.

➤ **Viewing a billing group**

   Though this procedure is for individual records, the procedure is similar for student and organization records.

1. From the Administration page in **Student Billing**, click **Manage billing groups**. The Manage Billing Groups screen appears.
2. In the **Record Name** field, enter the individual name or click the binoculars to locate the individual record.

3. To view an individual’s associated records, click the down arrow next to **Load all associated records** and select one of these options:
   - **Load all associated records** — Loads any record that is a relation, payer, or statement recipient for the selected individual.
   - **Load all related records** — Loads all records who are relations for the selected individual.
   - **Load all payers** — Loads all records who are payers for the selected individual.
   - **Load all statement recipients** — Loads all records who are statement recipients for the selected individual.
4. The individual and any associated records that meet the selected criteria appear in the **Records** box on the left. When you select a record in the list, biographical information for that record appears on the right. You can edit information on the Records, Defaults, or Addresses tabs for each record.

5. When finished viewing:

- Click **Finish and New** to save and close the individual record and open a new billing group automatically.
- Click **Finish and Close** to save and close the individual record and return to the Administration page.

➤ **Adding records to a billing group**

Tom Boatwright is a new teacher at your school. His wife, Marion, has taught there for several years. An individual record already exists for Marion so you create a new billing group to quickly add an individual record for Tom. You create a relationship between the records and copy Marion’s address to Tom’s record.

1. From the Administration page in **Student Billing**, click **Manage billing groups**. The Manage Billing Groups screen appears.
2. In the **Record Name** field, enter “Marion Boatwright” and click **Load all associated records**. Marion’s record appears on the screen.

![Manage Billing Groups window]

3. To add Tom to the billing group, click the down arrow next to **Add New Student** and select “Add New Individual”.

4. On the Records tab, enter biographical information for Tom.

![Manage Billing Groups window]

5. Select the **Defaults** tab.

6. Click **Relationships**.

7. In the **Name** column, select “Marion Boatwright”.

*If you limit users’ security rights to add records, we recommend that you also limit the rights to Manage Billing Groups. A user with rights to Manage Billing Groups can add any type of record.*
8. In the **Relationship** column, select “Wife” and in the **Reciprocal Relationship** column, select “Husband”. Mark the checkbox in the **Spouse** column.

9. Select the Addresses tab.

10. Click **Copy Address From**. Use the Open screen to select Marion’s record. The Addresses for Marion Boatwright screen appears.

11. Mark the checkbox for the address to copy and click **Copy Now**. The address appears on Tom’s record.

When you add or update a record using **Manage Billing Groups**, changes are not saved until you click **Finish and New** or **Finish and Close**.
When you click Finish and New or Finish and Close, a completion screen appears listing the number of new records created and the number updated.

12. To save the records and exit:
   - Click Finish and New to save and close the records and open a new billing group automatically.
   - Click Finish and Close to save and close the records and return to the Administration page.

Generating Fixed Amount Automatic Payments

Fixed automatic payments are set up on a regular schedule for a pre-determined amount. By generating fixed amount automatic payments, you create fixed amount payments for student, individual, or organization records. For each record you select using filters, Student Billing automatically creates one deposit record for the process and a payment record for each of the fixed amount scheduled payments.

Generating fixed amount automatic payments

1. From the Administration page in Student Billing, click Generate fixed amount automatic payments. The Generate Fixed Amount Automatic Payments screen appears.

2. To include payments for specific dates in fixed schedules, mark For fixed schedules, include payments with these dates. In the Dates field, select a date or a date range.
3. To include payments with unlimited schedules, mark **For unlimited schedules, include payments that meet this criteria.** In the field under the checkbox, select “Generate payments through” and enter a date or select “Generate specific number of payments” and enter a number.

4. In the filters grid, you can filter the records included in the processing. For more information about filtering criteria, see the *Program Basics Guide*.

5. To create an output query of the payment records included, mark **Create output query of payment records** checkbox.

6. Select the Deposit tab to enter information for the deposit record created in this process.

7. In the **Deposit date** field, enter a transaction date for the deposit.

8. In the **Entry date** field, enter an entry date for the deposit.

9. In the **Status** field, select “Open” or “Closed.”

10. In the **Description** field, enter a description of the deposit.

11. In the **Post status** field, select “Not yet posted” or “Do not post”.

12. In the **Post date** field, enter a posting date for the deposit.

13. In the **Bank account** field, select a **Student Billing** bank account. The **GL cash account** field displays the cash account assigned to the selected **Student Billing** bank account.

14. In the **Projected Deposit Totals** frame, enter numbers in the **Projected # of payments** and **Projected total** fields. You can use these numbers as accuracy checks before posting.
15. Select the Payment tab to enter information for the payment records created in this process.

![Generate Fixed Amount Automatic Payments](image)

16. In the **Payment date** field, select “Use scheduled date” or select “Use specific date” and enter the date.

   The **Post status** and **Post date** fields display the post information for the payment.

17. In the **Source** field, select a payment source.

18. In the **Comment** field, enter a comment.
19. Click **Preview** to view payment records. The Payments to Generate screen appears.

![](image)

20. In the **Generate** column, unmark the checkboxes for any payments you do not want to generate.

21. When you are ready to generate payments, click **Generate Now**.

22. A confirmation message appears when the process is complete. Click **OK** to return to the Administration page.

### Generating Transactions Automatically

Using **Generate Transactions Automatically**, you can automatically generate billing schedules and scheduled charges and credits. You can also generate Tuition Refund Plan (TRP) charges and determination table and reversal schedule transactions. To generate TRP charges, the program checks for TRP items on the records you are including and calculates the new TRP charge amount based on the percentage of the TRP item out of the amount of all the transactions included in the TRP calculation.

On the Generate Transactions Automatically page, you can select a saved parameter set or click **New** to add a new parameter set for transactions.

To help you filter the parameter sets, you can select a calculation type in the **Generate** field.

- **Generating transactions automatically**
  
  1. From the Administration page in **Student Billing**, click **Generate transactions automatically**. The Generate Transactions Automatically page appears.
2. Click **New**. The Generate Transactions Automatically screen appears.

![Generate Transactions Automatically screen](image)

3. In the **Generate** field, select how to generate transactions.
   - To both create billing schedules from bill codes and generate charges and credits, select “Automatic Billing Schedules and Scheduled Charges/Credits”. This includes advance deposits and financial aid. This will not generate TRP schedules, but will generate TRP charges from existing schedules.
   - To create only billing schedules from bill codes, select “Automatic Billing Schedules Only”. This will not generate TRP schedules.
   - To generate charges/credits for existing schedules only, select “Scheduled Charges/Credits Only”. This includes advance deposits, financial aid, and TRP.
   - To create TRP billing schedules and charges, select “TRP Schedules and Charges”. This calculates TRP charges based on billing schedules that would be created using bill codes. To exclude billing schedules that are not created yet, select “None” in the **Bill Codes** row on the Filters tab.
   - To generate student invoice line items, credits, and adjustments based on settings from the determination table, data from student and course records, and entries in reversal schedules, select “Determination Table and Reversal Schedule Transactions”.

4. If you are generating charges and credits, in the **For this range** field, select the date range or billing cycle to use.

5. If you are creating billing schedules, in the **Billing schedule transaction date** field, enter the date to determine which bill codes are used to create schedules and the transaction date for created schedules.
6. If you are creating billing schedules, in the **For automatic items without a bill code, generate billing schedules for** field, select “No Records” or “All Records”.

7. If you selected “TRP Schedules and Charges” in the **Generate** field, select the date range to use in the **Base TRP charges on this range** field.

8. In the **Add this comment to each transaction** field, you can enter a comment to add to each generated transaction.

9. To generate grade-based fees based on the student’s next grade using the promotion schedule, mark **For grade-based billing, use student’s next grade**.

   If you also have **Registrar’s Office**, instead of this checkbox you have the **For grade-based billing, use student’s grade as of** field, where you can enter a date as of which to generate the fees. The program refers to the student’s progression entry as of that date to determine the student’s grade.

10. If you selected “Determination Table and Reversal Schedule Transactions” in the **Generate** field:

    a. Select an academic year and session in the **Academic year** and **Session** fields.

    b. You can mark **Recalculate all included records** to recalculate existing invoice line items, credits, and adjustments. For example, you deleted credits for students and need to recalculate the credits the students should receive for withdrawing or dropping out of a class.

    c. In the **Generate transactions for** frame, mark what transaction types to automatically generate: **Course fees**, **Residence fees**, and **Meal plan fees**.

    d. In the **Transaction date** field, select the transaction date to record on the invoices, credits, and adjustments generated.

    e. If invoices do not number automatically (a setting in **Student Billing** business rules), enter an invoice number in the **Number invoices sequentially starting with [ ]** field.

11. To include payers whose records are on hold, mark **Include payers on credit hold**.

    If “Never” is selected for **Allow new charges when account is On Hold** in student, individual, or organization business rules, this checkbox does not apply to that record type. For more information about business rules, see the **Configuration Guide for Student Billing**.

12. To create a query of records not included in the processing, mark **Create an exception query**.

13. To print a control report, mark **Print control report on** and select a printer to print a control report on.
14. Select the Filters tab.

15. You can filter the records included in the processing. For more information about filtering criteria, see the Program Basics Guide.

16. Select the Transaction Defaults tab.

17. In the Due date field, select how to determine the due date for the charges generated.
Using a specific due date is useful if you generate transactions once a month, all with the same due date.

- If you select “Based on transaction date”, you can select to use a specific number of days from the transaction date, a specific day of the current or next month, or the same transaction date of the next month.
- If you select “Specific date”, a field appears for you to enter the date. If you use a specific date, be aware that this date will be used for all transactions included in the process.

18. In the **Post date** field, select how to determine the post date to use.
   - If you select “Based on transaction date”, you can select to use the transaction date, a specific number of days from the transaction date, a specific day of the current or next month, or the same transaction date of the next month.
   - If you select “Specific date”, a field appears for you to enter the date. If you use a specific date, be aware that this date will be used for all transactions included in the process.
   - If you select “Last date of GL Fiscal Period”, the last date of the current fiscal period is used.

19. In the **Post Status** field, select the post status to use on the transactions, either “Not Yet Posted” or “Do Not Post”.

20. To review the transactions that will be generated before actually generating them, click **Pre-Generation Report**.

21. When you are ready to generate the transactions, click **Generate Now**.

22. A confirmation message appears when the process is complete. Click **OK** to return to the Administration page.

## Globally Delete Transactions

When you use **Globally Delete Transactions**, you can undo transactions without restoring to a backup. You can only delete transactions that are not posted or have a post status of Not yet posted or Do not post. Use the global delete if you need to delete individual transactions as if they never existed. When you delete the transactions, they are permanently erased from the database. Globally delete transactions is different from archive and purge where a record of the purge is recorded in the general ledger. The only record of the transaction deleted is if you choose to save the parameter file and control report. The parameter file contains the parameters used to delete and the control report contains a basic log of the transactions deleted. We strongly recommend, however, that you create a backup of your database before you delete transactions. Once you delete the transactions, you can only restore them if you have a backup of your database.

You can choose to delete financial aid and generated credits, credits, charges, invoices, advance deposits and generated credits, payments, or billing schedules.

1. From the Administration page in **Student Billing**, click **Globally Delete Transactions**. The Globally delete transactions page appears.

3. In the **Delete** field, select which type of transactions to delete.

4. In **For this range** field, select which date range you want to delete transactions. Only the type of transactions you chose in the **Delete** field for the date range you choose will delete.

5. To create a query of records not included in the processing, select **Create an exception query**.

6. To print a control report, select **Print control report on** and select a printer on which to print the report.

7. Select the Filters tab.

8. You can filter the records included in the processing. For more information about filtering criteria, see the **Program Basics Guide**.

9. To review the transactions that will be deleted before you delete them, click **Preview Changes**.

10. When you are ready to delete the transactions, click **Delete Now**. A confirmation screen appears.

11. To delete, click **Yes**.

12. A confirmation message appears when the process is complete. Click **OK** to return to the Administration page.

**Import from Tuition Management Service**

You can import tuition transactions directly into **Student Billing** records. You select the tuition management service, select the import file, and specify the bank account to use. The import file format is a fixed length, 222-character text string.
Importing transactions from a tuition management service

1. From the Administration page of Student Billing, click Import from tuition management service. The Import Tuition Management Service Transactions screen appears.

2. In the Tuition management service field, select the service you use.

3. In the Import file field, click the browse button to search for and select the file to import.

4. In the Match records by using field, select whether to use a student ID or individual ID to match imported records with existing records. The ID type you select becomes a required field.

5. In the Bank account for deposit field, select a bank account.

6. In the Default application restriction field, select an application restriction or “<No Restriction>”. If you select an application restriction, it is assigned to the deposit created for this import and the deposit’s associated payments.

7. To print a control report, mark Print a control report on and select a printer.

8. To create a query of records included in the processing, mark Create output query of records.

9. To start the import, click Import Now.

10. A confirmation message appears when the process is complete. Click OK to return to the Administration page.

Import Fields
These are the fields available for import.

Record ID. Either Student ID, Individual ID, Student SSN, or Contract Number is required.

Transaction Type. This is required. A transaction type can be payment (PY), credit (CR), charge (CH), refund (RF), advanced deposit (AD), financial aid (FA), or fee schedule (FS).
**Fee Number.** This is required for credits, charges, refunds, advanced deposits, financial aid, and billing schedules. This becomes the billing item category and item in *Student Billing*. You cannot use the billing item categories of product or per usage when importing.

Fees imported through a tuition management service must have a 3-character ID. The ID can be alphanumeric.

**Date of Transaction.** This is required. This is used to identify the correct billing item.

**Amount of Transaction.** This is required. You cannot enter zero amounts for charges or refunds.

**Description.** This is not required. This appears as a comment in *Student Billing*.

**Paid By.** This is not required. This becomes a note in *Student Billing*.

**Source Code.** This is not required. This becomes a note in *Student Billing*.

**Posting Date.** This is used for charges, credits, and refunds with a post status of Not posted.

**Post Status.** This is used for charges, credits, and refunds. Values can be N for Not posted, P for Posted, or D for Do not post. The program resets P to D upon import to not affect the general ledger.

**Due Date.** This is used for charges and advance deposits.

**GL Account Number.** You can enter 7 characters here or set up the GL Account Numbers on the billing items in *Student Billing*.

**Pay Type.** This is required for payments and advance deposits. Values can be 1 for Cash, 2 for Check, and 3 for Other.

**Check Number.** For Cash or Other pay types, the program checks for check number first, then checks for reference number. This is used for payments and advance deposits.

**Check/Reference Date.** This is used for payments and advance deposits.

**Amount Bills.** For cash pay types, this must match the cash amount in bills. This is used for payments and advance deposits.

**Amount Coins.** For cash pay types, this must match the cash amount in coins. This is used for payments and advance deposits.

**Other Pay.** This becomes a note in *Student Billing*. This is used for payments and advance deposits.

**Reference Number.** For Cash or Other pay types, the program checks for check number first, then checks for reference number. This is used for payments and advance deposits.

**Parent/Guardian #.** This is the ID of an individual in *Student Billing* who is the payer. If a value is not entered, but there is one payer on the student record in *Student Billing*, that payer is used. If there are multiple payers on the student record, you receive an error and you must designate the payer to use in the import file. If there are no payers on the student record, it is assumed that the student record is its own payer.

We recommend that billing items already have GL distributions set up.
Contract Number. Either Student ID, Student SSN, or Contract Number is required. This is used to identify the relationship between a payer and a student, and to apply the payment to the correct student.

Student SSN. Either Student ID, Student SSN, or Contract Number is required.

Carriage Return/Line Feed. This is optional.

Creating Financial Aid Schedules

You can create financial aid schedules for students based on their financial aid application information. To create financial aid schedules, the program looks at amounts of financial aid that are granted based on your filters.

This process does not generate individual transactions. For information about generating transactions automatically, see “Generating Transactions Automatically” on page 103.

➤ Creating financial aid schedules

1. From the Administration page of Student Billing, click Create financial aid schedules. The Create Financial Aid Schedules screen appears.

2. In the Transaction date field, enter the date of the transaction.

3. In the Qualification date field, select the date of the items to include based on the date in the Date qualified field on the financial aid application.

4. In the Grant date field, select the date of the items to include based on the date in the Date granted field on the financial aid application.

5. To include only financial aid with the Accepted checkbox marked on the financial aid application, mark Include only accepted financial aid qualifications.
6. To combine all financial aid items with the same billing item, mark **Combine financial aid with the same billing item**.

7. To create a query of students not included in the processing, mark **Create exception query of students**.

8. To create a query of students included in the processing, mark **Create output query of students**.

9. To print a control report, mark **Print a control report on** and select a printer.

10. Select the Financial Aid Types tab.

11. In the **Type** column, select a type of financial aid.

12. In the **Billing Item** column, select a billing item to associate with each financial aid type. You can select to use the same billing item for multiple types of financial aid. The date range is also included in the billing item name so you can easily search for the applicable item.

13. The billing item’s description appears in the **Description** column.
14. Select the Filters tab.

![Filters Tab]

15. You can filter the records included in the processing. For more information about filtering criteria, see the Program Basics Guide.

16. Select the Attributes tab.

![Attributes Tab]

17. In the Action column, you can select to add an attribute.

18. In the Attribute Type column, select an attribute type.

19. In the Description column, enter or select a description for the attribute type.
If you selected a table type attribute that uses short descriptions, you select the attribute description in the **Short Description** column. The **Description** column completes automatically.

20. In the **Date** column, enter the date you add the attribute or another date relevant to the attribute.

21. If the attribute is required, the checkbox is marked in the **Required** column.

22. In the **Comments** column, enter any additional information about the attribute.

23. Select the Preview tab.

24. Unmark the checkbox in the **Include?** column for any students and billing item combinations you do not want to include.

25. To review a report of what will be processed before actually creating the financial aid schedules, click **Preprocessing Report**.

26. When you ready to create the financial aid schedules, click **Process Now**.

27. When the process is complete, a completion screen appears.
28. To open the control report, click View Control Report.
29. To close the screen and return to the Administration page, click Close.

**Globally Add Hold Codes**

From Student Billing or, if you have Registrar’s Office, click the Globally Add Hold Codes link on the Administration page to add hold codes to a group of student records.

➤ **Globally add hold codes**

While this procedure explains how to globally add hold codes in Student Billing, you can use the same steps in Registrar’s Office.

1. From the Administration page of Student Billing, click Globally Add Hold Codes. The Globally Add Hold Codes screen appears.

2. In the **Query name** field, click the binoculars to locate a query of student records you want to add hold codes. If you have not created a query of the records, you can click Add a New Query on the Open Query screen.

3. In the **Hold code** field, select the hold code to add to the student records.

4. In the **Start date** field, enter a start date for the hold code.

5. In the **End date** field, enter an end date for the hold code, if one exists.

6. In the **Reason** field, you can edit the reason for the hold code or use the default reason you entered in Configuration.

7. To print a report of the student records assigned a new hold code, mark Print control report.

8. To create a query containing the students who were not assigned the hold code, mark Create exception query.

9. To review a preprocessing report before globally adding the hold code, click Preprocessing Report. The report lists the successfully added hold codes, student records with exceptions, and a description of the exceptions.

You define hold codes in Configuration. For more information about how to define hold codes, see the Configuration Guide for Student Billing.
10. When you are ready to begin the global add, click **Add Now**. When the add is complete, a confirmation screen appears.

11. To view the control report, click **View Control Report**.
12. Click **Close**. You return to Administration page.

**Payroll Administration**

On the Administration page in *Payroll*, you can access the accrue attendance expenses task.

**Accruing Attendance Expenses**

You can accrue unused attendance balances for employees. The program calculates the balances as of a date you specify and creates an open batch in *Journal Entry* with reversal entries for the amount.

If you use different expense and liability accounts for each attendance type, you have to accrue attendance separately for each attendance type and change the account distributions for each run.
Accruing attendance expenses


2. In the Balances as of field, select the last date to include in the calculation.

3. In the Post date field, select the post date to use on the reversal entries created.

4. In the Reverse on field, select the date to use on the reversal entries created.

5. To include negative or zero attendance balances in the calculation, mark Include negative or zero attendance balances. For example, an employee who has taken more vacation time in the current year than has been accrued for the year-to-date will reduce the amount to accrue.

6. To create an output query of employees included in the processing, mark Create an output query of employees.
7. Click Next or select the GL Distribution tab.

8. You must define both a debit and credit distribution. In the Distribution field, select “Debit (DR) distribution”.

9. Select the account to use in the debit distribution. To associate an employee distribution with a specific account code, mark Combine employee distribution with this account code and enter the account code. You can click the binoculars to search for an account code. Or, mark Always debit this account and enter the account to use. You can click the binoculars to search for an account.

10. If you have the optional module Projects and Grants, you can associate a transaction distribution with the debit account. Mark Always use this transaction distribution. In the transaction distribution grid, you can enter transaction distribution information in one or more rows. You can split distributions among multiple projects, classes, or transaction codes if necessary.

    - In the Project ID column, enter a project ID number or click the binoculars to search for a project ID. When you enter a valid project ID number, the description automatically appear in the Project Description column.

    - In the Percent column, enter the percentage of the distribution. You can manually enter percents for each row or you can click Distribute Evenly to distribute percents equally among the rows.

    - In the Class column, select a class for the distribution.

    - If you have defined transaction codes, additional columns appear based on the number of transaction codes you have defined. You can select a value for each transaction code.

If you use a cash account associated with Cash Management on a bank record, the program also creates a cash management adjustment.

To load a default transaction distribution, click Load Distribution below the transaction distribution grid and select a distribution to use.
11. To attach transaction attributes to the account in the debit distribution, click Attributes on the action bar above the distribution grid. When you have finished entering information, click OK to return to the GL Distribution tab.

12. In the Distribution field, select “Credit (CR) distribution”.

13. Select the account to use in the credit distribution. To associate an employee distribution with a specific account code, mark Combine employee distribution with this account code and enter the account code. You can click the binoculars to search for an account code. Or, mark Always credit this account and enter the account to use. You can click the binoculars to search for an account.

14. If you have the optional module Projects and Grants, you can associate a transaction distribution with the credit account. Mark Always use this transaction distribution. In the transaction distribution grid, you can enter transaction distribution information in one or more rows. You can split distributions among multiple projects, classes, or transaction codes if necessary.

- In the Project ID column, enter a project ID number or click the binoculars to search for a project ID. When you enter a valid project ID number, the description automatically appear in the Project Description column.
- In the Percent column, enter the percentage of the distribution. You can manually enter percents for each row or you can click Distribute Evenly to distribute percents equally among the rows.
- In the Class column, select a class for the distribution.
- If you have defined transaction codes, additional columns appear based on the number of transaction codes you have defined. You can select a value for each transaction code.

To load a default transaction distribution, click Load Distribution below the transaction distribution grid and select a distribution to use.
15. To attach transaction attributes to the account in the credit distribution, click **Attributes** on the action bar above the distribution grid. When you have finished entering information, click **OK** to return to the GL Distribution tab.

16. In the **Interfund** field above the distribution grid, select an interfund set to balance the accounts if you enter debit and credit accounts from different funds. If you have not created a balancing interfund set for those accounts in *Configuration*, you cannot save the distribution.

17. Click **Next** or select the Filters tab.

18. You can select filters to designate the employees included in the accrual. If you do not select any filters, all employees will be included. For more information about filtering criteria, see the *Program Basics Guide*. 
19. Click **Next** or select the Miscellaneous tab.

20. In the **Post Options** frame, you can specify additional details about the journal entries to create. In the **Journal** field, select the journal associated with the entries.

21. In the **Reference** grid, define the journal reference to use when posting. You specify the fields to export and their lengths.

22. To restore the original default field settings, click **Restore Defaults**.

23. In the **Report Format** frame, you can specify additional details to include in the pre-accrual and control reports. To include a summary of debits and credits by account number, mark **Show account summary**.

24. To include a summary of debits and credits by account characteristic, mark **Show combined totals for account characteristics**.

25. To include a summary of debits and credits by transaction characteristic, mark **Show transaction distribution detail**.

26. To print a control report, mark the **Print a control report on** checkbox and select a printer.

27. To run a report to review before beginning the accrual, click **Pre-Accrual Report**. The Attendance Pre-Accrual Report appears.

28. To begin the accrual, click **Accrue Now**. The program creates an open journal entry batch in **General Ledger**. The Attendance Accrual Report appears.

29.
Global Change

Contents

Global Change Tabs .......................................................... 124
General Tab .......................................................................... 125
Filters Tab ........................................................................... 127
  Selected Filter Screens ....................................................... 128
Global Change Operations ................................................... 129
Add ....................................................................................... 130
Replace ................................................................................. 131
Partial Replace ..................................................................... 131
Delete ................................................................................... 131
Increase/Decrease ............................................................... 131
Copy ..................................................................................... 132
Swap ..................................................................................... 132
Move ..................................................................................... 132
Globally Changing Records ................................................ 132
You can change information in your database for a specified group of records. Using a global change, you can add, replace, partially replace, delete, increase/decrease, copy, swap, or move information, depending on which field you select to change. You can save a global change to run again as originally created or with modifications.

After globally changing information, you can view a control report detailing all the records in your database that were changed or not changed, and why. Also, you can create a query of records that were changed and an exception query of records that cannot be changed. You can use these queries in other areas of the program.

In security settings, the supervisor can restrict the rights that allow users to globally change records. If a user does not have rights, the Globally change records link does not appear on the Administration page. Furthermore, users must have rights to globally change Social Security, credit card, and bank account numbers. For more information, see the Security chapter of the Administration Guide for The Financial Edge.

Global Change Tabs

For a specific record type, you can make a global change to all records or a select group of records in your database. For example, if a telephone area code changes, you can use the partial replace operation to globally replace the old area code with the new one. If only certain cities are affected by the new area code, you can filter by a query of records containing specified city names in their addresses.

When creating a global change, you define change operations on the General tab and filter the records affected by the global change on the Filters tab. You can save a global change and run it later as it is or with modifications.
General Tab

On the General tab, you select the fields to which you want to make changes and specify the type of change you want to make.

**Available fields.** In the **Available fields** box, highlight the field you want to change and click **Select**. You can use the drop-down list, which defaults to `<All fields>`, to filter fields appearing in the box.

When you select a field, the Edit Change Parameters screen appears, on which you specify the type of global change. For more information, see “Global Change Operations” on page 129.

**Apply changes to these fields.** The change parameters you set appear in the **Apply changes to these fields** box.

**Find.** Click **Find** to search subcategories in the **Available fields** box. The Find function searches only expanded categories.

**Select.** Use **Select** to choose fields to change. When you click **Select**, the Edit Change Parameters screen appears.

**Remove.** Click **Remove** to remove fields from a global change. You must highlight the field in the **Apply changes to these fields** box and then click **Remove**.

**Criteria.** Click **Criteria** to edit the item you select in the **Apply changes to these fields** box. The Edit Change Parameters screen appears, and you can edit the change parameters for the selected field.
Browse Changes. Click **Browse Changes** to view a sampling of selected changes. This button is active only if you are copying, moving, swapping, replacing, or partially replacing a field.

Create a query of [] that have changes. Mark this checkbox to create a static query of all the records affected by the global change. For more information about queries, see the **Query Guide**.

Create control report. Mark this checkbox to view a list of records affected by the global change and information about records that could not be changed after the global change is run.

Automatically add new table entries. Mark this checkbox to add new table entries to code tables when copying, swapping, or moving data to a field that has values from a table. If you do not mark this checkbox, you may receive exceptions for fields that could not be changed; however, you may want to review the types of new entries being added before making a large global change that cannot be undone globally.

Create query of exceptions. Mark this checkbox to create a static query of records that the global change did not change. For more information about queries, see the **Query Guide**.

Cancel. Use **Cancel** to exit the Global Change screen without saving changes.

Preview Changes. Use **Preview Changes** to view change parameters before you process a global change.

Change Now. Click **Change Now** to process a global change. Changes cannot be undone, so we strongly encourage you to preview changes prior to making them.
Filters Tab

You use the Filters tab to select the records in which you want to make a global change. On this tab, you can include all, selected, or a range of records. With some filters, you can also create a new query or use an existing query to filter by a specific group of records you want to globally change.

Open. When you highlight a filter in the grid and click Open, the Selected filter screen appears so you can edit filter settings. For more information about this screen, see “Selected Filter Screens” on page 128.

Clear All Filters. Click Clear All Filters to remove all filter parameters.

Filters. The Filters column displays the available filters for the selected record type to which you are making global changes.

Include. If you want to filter the records being changed, you choose Selected in the Include column for each filter you want to use. The Selected filter screen appears.

Selected Filters. The Selected Filters column displays your filter selections. You can click the binoculars in the field to open the Selected filter screen after you mark Selected in the Include column.

Cancel. Use Cancel to exit the Global Change screen without saving changes.

Preview Changes. Use Preview Changes to view change parameters before you process a global change.
**Change Now.** Use Change Now to process a global change. Changes cannot be undone, so we strongly encourage you to preview changes prior to making changes.

**Selected Filter Screens**

Two types of Selected filter screens can appear with additional fields and options. Screen options vary depending on the filter type.

**Include.** For each filter, you can select to include all or select specific filters. Depending on the filter, you may also be able to filter by a range or query.

**All.** If you mark All, you cannot designate specific filters.

**Selected or Range.** If you mark Include: Selected or Range, a grid appears in which you can specify filters. In a field, you can click the binoculars to search for information.

**Query.** If you mark Query, the Query name field appears for you to enter the name of the query by which to filter the report. In the field, you can click the binoculars to search for the query name.

To create a new query, click the binoculars. Then click Add a New Query on the Open Query screen. For more information about creating queries, see the Query Guide.

**Previous Filter.** To view or edit the previous filter without returning to the Filters tab, click Previous Filter.

**Next Filter.** To view or edit the next filter without returning to the Filters tab, click Next Filter.

**OK.** When you are finished specifying filters, click OK.
**Global Change Operations**

The Edit Change Parameters screen appears when you highlight a field in the **Available fields** box on the General tab and click **Select**. In the **Operation** field you select to add, replace, partially replace, delete, increase, decrease, copy, move, or swap information in the field. Not all operations are available for every type of change. Depending on your selection in the **Operation** field, additional fields appear for you to enter information about the specific change.
For example, if you select the Replace operation, you must select or enter the current data you want to change in the Replace field and the new data with which you want to replace it in the With field.

For some record type fields, you can use the options Match case and Use pattern matching.

**Match case.** If you mark Match case, the program searches for the value exactly as you enter it in upper case or lower case letters. For example, you can search for only “south” and not “South”.

**Use pattern matching.** With pattern matching, you can search using wildcards in place of a letter or letters. Use an asterisk (*) to match any number of characters or use a question mark (?) to match any single character. When you select Use pattern matching, the Find whole words only option is enabled. For example, if you want to change only text containing the word “South” and not “Southern”, you should mark Find whole words only.

**Add**

The Add operation adds a value to empty fields and either replaces existing current values with the new value or makes no changes to fields already containing a value.

- If you do not mark Overwrite existing value, only empty fields receive the new value. Fields with existing values are not modified.
- If you mark Overwrite existing value, the program replaces the existing values in the field and adds the new value to empty fields.

For example, if you are globally adding the class “Unrestricted net asset” to accounts. If you leave Overwrite existing value unmarked, “Unrestricted net asset” is added only to records with no selected class. Records with a selected class remain unchanged. If you mark Overwrite existing value, the program replaces the class value in every account with “Unrestricted net asset”, regardless of the original class value.

If you are adding an attribute that does not exist on a record yet, you must select Attribute from the Available fields box. If you want to add information to an attribute already existing on a record, you can select specific fields listed under a named attribute in the Available fields box.
Replace

The Replace operation searches for records that exactly match the value. For example, you can replace the value “One payment per invoice” with “One payment for all invoices” in the Payment Option field of a vendor record in Accounts Payable. Select “One payment per invoice” in the Replace field and “One payment for all invoices” in the With field. The program changes the payment option for all selected records in the global change.

If you want to replace a field value with an empty value, enter the value you want to overwrite in the Replace field and leave the With field blank. You cannot leave the With field blank for required fields, such as the phone type field.

Partial Replace

The Partial Replace operation searches for records containing the selected value. In a partial replace global change, you cannot replace a value with a blank as you can with the Replace function. You must enter or select data in the Partially replace field.

For example, you can use Partial Replace to change the phone area code 803 with a new area code 843 for records you have selected in a query. Because the phone number field you are changing contains the entire phone number, you must use Partial Replace to replace only the first three digits with the new value. The remainder of the phone number stays unchanged.

Delete

The Delete operation removes the specified value from the selected field.

For example, if your organization wants to clean up the database and remove account attributes that are no longer relevant. In an account global change, you can delete an entire attribute from all or specified account records by selecting Attribute in the Available fields box. On the Edit Change Parameters screen, you must enter an Attribute type. If you leave the other fields blank, the attribute is deleted from every record. If you enter information in the other fields, only the attributes containing the specified information are deleted from records.

Increase/Decrease

The Increase/Decrease operation increases or decreases numeric values in fields by an exact amount or percentage. When increasing or decreasing values by a percentage, you specify the number of decimal places to which the final value should be rounded. For fields containing a date value, you increase or decrease the date by a specified number of days, weeks, months, or years. Increases and decreases take into account months with different lengths and leap years.

Copy
The Copy operation places the entire value of the source field into a compatible target field. To select the target field for the information you are copying, you click the binoculars in the Copy to field.

The Copy function always copies the specified value to empty target fields and either replaces existing current values with the new value or makes no changes to fields already containing a value.

- If you do not mark Overwrite existing value, only empty fields receive the copied value. Fields with existing values are not modified.
- If you mark Overwrite existing value, the program replaces the existing values in the field and adds the copied value to empty fields.

Swap
The Swap operation places the entire value from the source field into the target field, and the original value of the target field into the source field. In the Swap with field, click the binoculars to select the target field.

Move
The Move operation places the entire value of the source field into the target field and deletes the value from the source field. In the Move to field, click the binoculars to select the target field.

You cannot delete, move, or replace required fields with a <blank>. You can only copy unique required fields.

Globally Changing Records
You can use a global change to add, edit, or delete a wide variety of record types in your database without accessing each record individually. We strongly recommend you completely back up your database before performing a global change.

Understanding the different record types is essential to successfully completing a global change. Selecting a specific record type instructs the program to include only records for that record type in the global change. The program globally changes every record of that type unless you use filters on the Filters tab to limit changes to only certain records.

Although this section contains a scenario procedure for performing a partial replace global change, the procedure is similar for all global change functions.
Globally changing information on a record using partial replace

The telephone company has added a new area code in your state. The old area code 803 remains in use in many cities but will be replaced by 843 in other cities. You have determined which cities are affected by the change and have created a query containing vendors in those cities. Now you want to globally change your vendor records to reflect the new area code.

1. On the Globally change records page of Administration in Accounts Payable, select Vendors from the tree view.

The Globally change records link does not appear on the Administration page for users without security access to this feature.
2. Click **New Change** on the action bar. The Global Change - Vendor screen appears. In the tree view, click the plus sign next to **Vendor Address** to expand the field list.

![Global Change - Vendor](image)

3. Under **Vendor Address**, click the plus sign next to **Phone** to expand the field list. Highlight **Number** and click **Select**. The Edit Change Parameters screen appears.

![Edit Change Parameters](image)

4. In the **Operation** field, select “Partial Replace”. In the **Partially replace** field, enter “803”. In the **With** field, enter “843”.

![Edit Change Parameters](image)
5. Click **OK**. You return to the Global Change - Vendor screen. The change parameters appear in the **Apply changes to these fields** box.

![Global Change - Vendor dialog box](image)

6. To create a query of records that are changed, mark **Create query of vendors that have changes**. To create a query of records that cannot be changed, mark **Create a query of exceptions**.

7. Mark **Create control report** and select “Preview report”. Later, when you run the global change, the control report will appear after you view change statistics. You can print the report from the Preview Report screen.

8. Select the Filters tab.

9. Select the row for the Vendors filter and click **Open** on the action bar. The Selected Vendors screen appears.

For more information about queries, see the *Query Guide*. 
If you need to create a query, on the Open Query screen you can click **Add a New Query**. For more information about creating queries, see the **Query Guide**.

10. Mark **Query**. Click the binoculars to find the query by which you want to filter. Select it on the Open Query screen and click **Open**. It appears in the **Query name** field.

11. Click **OK**. You return to the Global Change screen.

12. Click the **Save** button on the toolbar. The Save Global Change As screen appears.

13. In the **Name** field, enter a name for your global change. In the **Description** field, enter a description.

14. Click **Save**. You return to the Global Change screen.
15. To check the records before globally changing them, click **Preview Changes**. The Preview Modifications screen appears.

16. To remove any records from the global change process, unmark the checkbox in the **Change?** column. To run the global change, click **Change Now**.

17. When you run the global change, you are prompted to save the exception query and query of records changed. On the Save Static Query screens, enter a name and description and click **Save**.

18. When the global change is complete, a screen appears showing the global change statistics.

19. Click **Close**. The Global Change Control Report appears. To print the report, click the print button.

   Close the report when you are finished viewing it. You return to the Global Change - Vendor screen.

20. To close the global change, select **File, Close**.
Globally adding an attribute to a record

You have created an attribute named Grant Manager in Configuration. Now you want to add it to every project record. You must have the optional module Projects and Grants installed to have project records.

1. On the Globally change records page in Administration in General Ledger, select Projects from the tree view.
2. Click **New Change** on the action bar. The Global Change - Project screen appears. In the tree view, click the plus sign next to **Attributes** to expand the field list.

![Global Change - Project screen](image)

3. Under **Attributes**, select **Attribute** and click **Select**. The Edit Change Parameters screen appears.

4. In the **Operation** field, select “Add”. In the **Value** column next to Attribute type, select “Grant Manager”.

   If you want to specify a **Description**, select one in the **Value** column; however, be aware this description will appear on every record affected by the global change.

![Edit Change Parameters](image)
5. When you are finished specifying change parameters, click **OK**. You return to the Global Change - Project screen. The change parameters appear in the **Apply changes to these fields** box.

6. To create a query of records that are changed, mark **Create query of [ ] that have changes**.

To create a query of records that cannot be changed, mark **Create a query of exceptions**.

7. Mark **Create control report** and select “Preview report”. Later, when you run the global change, the control report will appear after you view change statistics. You can print the report from the Preview Report screen.

8. Click the **Save** button on the toolbar. The Save Global Change As screen appears.

9. In the **Name** field, enter a name for your global change. In the **Description** field, enter a description.

10. Click **Save**. You return to the Global Change screen.
11. To check the records before globally changing them, click **Preview Changes**. The Preview Modifications screen appears.

![Preview Modifications for Project](image)

12. To remove any records from the global change process, unmark the checkbox in the **Change?** column.

13. To run the global change, click **Change Now**.

   When you run the global change, you are prompted to save the exception query and query of records changed. On the Save Static Query screens, enter a name and description and click **Save**.

14. When the global change is complete, a screen appears showing the global change statistics.

![The Financial Edge - Global Change](image)

15. Click **Close**. The Global Change Control Report appears. To print the report, click the print button.

   Close the report when you are finished viewing it. You return to the Global Change - Project screen.

16. To close the global change, select **File, Close**.
Security

Contents

Accessing Security .................................................. 144
Supervisor Procedures ............................................... 145
Passwords ............................................................. 147
Security for Groups ................................................. 149
Managing Security Groups ....................................... 149
  Understanding Group Privileges ............................... 156
  Security for Shared Components ............................. 158
Security for Users .................................................. 162
Deleting a user ...................................................... 170
Advanced Security .................................................. 171
By establishing security rights for your users, you can ensure the validity, consistency, and confidentiality of your data and determine which users can change or delete important records. By limiting viewing rights, you can control who sees sensitive information.

Security is based on groups and users that are members of groups. You identify the records and functions users access by creating a group and assigning users to that group. When a user logs into a program, the records and functions to which the user has rights are accessible and all other records and functions are unavailable.

We recommend reviewing the components and privileges of each program to determine the best security configuration for your organization. When security is properly set up, you are ensured that users are accessing only the areas you allow.

**Accessing Security**

You can access security by clicking **Set up system security** on the Administration page of any program.

1. From the navigation bar, click **Administration**. The Administration page appears.
2. Click **Set up system security**. The Set up system security page appears.

![Set up system security page](image)

3. To return to the Administration page, click **Back**.

**Supervisor Procedures**

We ship the program with “admin” as the Supervisor password. The Supervisor user name can access all areas of the program. For security purposes, it is very important that you change the Supervisor password immediately.

When you log into your **Financial Edge** database as Supervisor, you have rights to perform all functions, such as globally changing or deleting vendor records. Because the Supervisor’s rights are so vast, we recommend you use a login with more limited security rights for routine work within the database. Doing so ensures you stop to consider the implications before making changes that may permanently alter your data.

There is only one Supervisor login; however, Supervisor rights can be assigned to other users. We recommend at least two users have Supervisor rights. Each user with these rights can access all areas of the program. These users should also know the password for the Supervisor user name.

The Supervisor and users with Supervisor rights have full access to all areas of the program. We recommend you limit the number of users with Supervisor security rights and knowledge of the Supervisor password.
Changing the Supervisor password

Once the Supervisor password is changed, we recommend keeping it in a secure location accessible by at least two users.

1. From the Set up system security page, select Supervisor and click Open on the action bar. The User - Supervisor screen appears.

2. Enter a new password in the Password field. The password must be at least eight characters, and include one alphabetic character and one non-alphabetic character.

3. Reenter the password in the Confirm field.

4. To return to the Set up system security page, click Save and Close.

Assigning Supervisor rights

1. From the Set up system security page, select the user to whom you want to assign Supervisor rights.
2. On the action bar, click **Open**. The User screen for the selected user appears.

3. In the **Groups for <Organization Name>** frame, mark **Supervisor rights**.

4. To save the change and return to the Set up system security page, click **Save and Close**.

### Passwords

Each user must have a password to access the program. We recommend a unique password for each user. The Supervisor, or a user with Supervisor rights, can define and edit passwords from each user record.

A Supervisor can also grant users the right to change their own passwords by marking the **User can change password** option on the user’s security record. To change their password, the user needs to log into *The Financial Edge* and then select **Edit, Change Password** from the menu bar.
Changing a user’s password

1. From the Set up system security page, select a user and click Open. The User screen for the selected user appears.

2. In the Password field, delete the current password and enter a new password. The password must be at least eight characters, and include one alphabetic character and one non-alphabetic character.

3. Re-enter the new password in the Confirm field.

4. If entries in both the Password and Confirm fields are not identical, the following message appears when you try to save the record.

5. Click OK and re-enter the new password in the Password and Confirm fields.

6. To save the changes and return to the Set up system security page, click Save and Close.
Security for Groups

Security is based on groups and users that are members of groups. You identify the records and functions users access by creating a group with specific rights and assigning users to that group. When a user logs into a program, the records and functions to which the user has rights are accessible and all other records and functions are unavailable.

The first step in establishing security is to create security groups. Groups are composed of users who perform similar tasks or have similar responsibilities and, therefore, have similar security needs. Give the groups descriptive names you can easily identify, and then assign rights to a group based on the areas of the program to which you want its members to have access.

For new installations of the program, and when you add a new database, you have three ready-to-use security groups to help you start quickly with maintaining system security. These groups are accessible on the Set up system security page. You can assign users to the Reporting Only group if they need to create report parameter files and run reports; the Read Only group if they need to view data in the system; and the Data Entry group if they need to view, enter, and manipulate data but not administer the system. The pre-created groups do not include users. You must create users and assign them to the groups. It is very important to review these groups to ensure they are appropriate for your organization.

Managing Security Groups

By creating a security group and assigning users, you determine what areas of the program users can access. Properly setting up security ensures that users are accessing only the areas that you specify. We recommend thoroughly reviewing the privileges for each program.

You can create as many different groups as you need. As users are added to security, you can make them members of groups that grant them the appropriate levels of access.
Adding a security group

1. From the Set up system security page, click **New Group** on the action bar.
   The New Group screen appears.

   ![New Group screen](image)

2. In the **Group name** field, enter a name for the user group. This name must be unique and no longer than 30 characters. We recommend you use a descriptive name for each group that you can easily remember.

3. In the **Description** field, enter a description for the user group.

4. In the **Group type** field, select the type of group you want to create. Your selection changes the options that appear on the Group Privileges tab.

5. In the **System Components** box, select a program or component. To restrict users from accessing the program, unmark the checkbox. With the box marked, a list of security privileges appears in the **Privileges** box on the right.

6. In the **Privileges** box, unmark the checkbox to prevent the group from accessing that area of the program. Leave the checkbox marked to allow the group access.

If you make a user with Supervisor rights a member of a security group, his Supervisor rights are not affected.

You can also access the New Group screen by double-clicking **Groups** in the tree view.
7. To define additional levels of security, select a privilege and click Options. The Security Options screen appears.

8. In the box on the left, select a security option. If the option has additional security privileges, they appear on the right.

9. Mark the checkbox in the View, Add, Edit, and Delete columns for the program areas the group can access.

10. Some privileges have miscellaneous options. Mark a checkbox to give the group access or unmark to deny access to a function.

11. When you finish, click OK to return to the New Group screen.
12. Select the Group Members tab.

13. Select a user from the Not Members box. Click the single right arrow to move the user to the Members box. Click the double arrows to move the entire list.
14. To return to the Set up system security page, click **Save and Close**.

- **Editing security group information**

  You can change the members and rights of a security group. The changes will not take effect until the member signs out and logs back into the program.

  1. From the Set up system security page, select a group and click **Open**. The Group screen appears.

  ![Group screen](image)

  2. On the Group Privileges tab, you can edit information in the **System Components** and **Privileges** boxes. To edit security options, select a privilege in the **Privileges** box and click **Options**.
3. On the Group Members tab, you can add and remove users from security groups. Click the single arrow to move an individual or the double arrows to move all users.

4. To return to the Set up system security page, click **Save and Close**.
Deleting a security group

Deleting a security group does not delete the users of the group. You can re-assign the group’s members as members of other groups.

1. From the Set up system security page, select the group to delete and click **Open**. The Group screen appears.

2. On the toolbar, click the **Delete** button. A confirmation message appears.
3. To delete the security group and return to the Set up system security page, click **Yes**.

Printing a security group profile report

Before you delete a security group or make significant changes, we recommend you print a security group profile.

1. From the Set up system security page, select the group whose profile you want to print.
2. Click **Open**. The Group screen appears.

3. To preview the report, select **File, Print Preview**.

4. To print the report, select **File, Print**.

5. To return to the Set up system security page, select **File, Close**.

**Understanding Group Privileges**

We recommended thoroughly reviewing the privileges of each program to determine the best use for your organization. When security is properly set up, you are assured that users access only the areas you allow.
When you select a program, items that comprise it appears in the **Privileges** box. These are the same items that appear on the navigation bar in the program shell.

If you select **Records** in the **General Ledger Privileges** box and click **Options**, the Security options screen appears. In the **Record Types** box, the record types for **General Ledger** appear. These are the same items that you see when you click **Records** on the navigation bar.

If you do not use a certain record type, you can unmark the checkbox in the **Record Types** column. The record type will not appear in **Records**.
Select Account in the Record Types column. The Accounts Privileges box lists the tabs on an account record.

For each option, mark View, Add, Edit, or Delete to assign group rights for that option. For example, if you unmark Add for the Notes tab, the group cannot add notes to an account record; however, the group can view and edit notes. N/A indicates an option is not available for the selected tab.

View. Mark View to allow a group to see the information in the specified record but not make changes.

Add. Mark Add to allow a group to add a record of the specified item, but not make changes.

Edit. Mark Edit to allow a group to make changes to the specified record.

Delete. Mark Delete to allow a group to delete the specified record.

The Miscellaneous Options box lists additional functions to which you can give the group access. Activate/deactivate accounts is a miscellaneous option for an account record. Marking the box gives the group rights to activate and deactivate account records. Unmarking the box denies the group the ability to do this.

Security for Shared Components

Shared components are portions of The Financial Edge shared among programs. Shared components consist of Shared Tables such as title and state tables; Shared Components such as system security, banks, and encryption for personal information; and Shared Configuration Information such as international settings.
If you select **Shared Components** from the **System Components** column, you can view the items that are shared among programs. The system components listed depend on the programs you have installed.
Banking Security

Select Bank Accounts from the Shared Component Privileges box and click Options to view the Security Options screen. In the Bank Accounts column, select Bank Account Information to see the tabs that appear on a bank account record.

For each tab, mark View, Add, Edit, or Delete to assign group rights to that tab. For example, if you unmark Add for the Notes tab, the group cannot add notes to a bank account record; however, the group can view and edit notes. N/A indicates an option is not available for the selected tab.

View. Mark View to allow a group to see the information in the specified record but not make changes.

Add. Mark Add to allow a group to add a record of the specified item, but not make changes.

Edit. Mark Edit to allow a group to make changes to the specified record.

Delete. Mark Delete to allow a group to delete the specified record.

Personal Information Encryption

The Financial Edge encrypts personal information such as Social Security, tax ID, and bank account numbers. This means that this information is always masked on screens, reports, queries, and exports unless a user has security rights to add, edit, delete, view, or output personal information. It is very important that your organization considers best practices for managing personal information before you grant security rights.

To protect personal information in your database, it is recommended that your organization:

Personal information refers to Social Security numbers and bank account numbers.
• Restricts access to personal information to only users with a specific need to view it.

• Ensures that users in contact with personal information understand their responsibilities.

• Does not send email containing personal information.

You should plan for processes that require users to view personal information. For example:

• During data entry, users must enter or import Social Security, bank account, and tax ID numbers on records. Users with security rights can view these numbers while entering them in fields, but the numbers are masked once the record is saved or reopened to edit.

• Checks and EFT notices will always mask bank account numbers or Social Security numbers. You should have strict controls on who can access these documents.

• Payroll systems store employee Social Security numbers for tax reporting. Social Security numbers should be protected so they are visible to only individuals that enter Social Security numbers when new employees are hired and to individuals that create tax reports for employees.

Select **Personal Information** from the **Shared Component Privileges** box and click **Options** to view the Security Options screen.

Three options appear:

- **Personal Information Data Entry** — Marking this option allows a group to add, delete, or edit personal information on records, on Fast! datasheets, and via the API. They can also globally change or import personal information but they cannot output personal information.

  Once the record or datasheet is saved, personal information is masked so the group cannot view it. When editing personal information, users must delete the entire masked value before they can enter a different value.

  **Personal Information Output** — Marking this option allows a group to output personal information through mailings, reports, export files, import files, and the API. They cannot add, remove, edit, or view personal information on records or datasheets. If users do not have this right, they can output personal information, but it is always masked.
- **Personal Information View** — Marking this option allows a group to view personal information on records, datasheets, and via the API, but they cannot add, delete, edit, or output personal information.

**Security for Users**

An individual user’s security privileges are determined by the group. You add users to security and then define their levels of access by assigning them to security groups. Using groups ensures data consistency, integrity, and confidentiality by limiting access to records and functions to the users who need it. A user can be a member of multiple groups.

➤ **Adding a user to a security group**

1. From the Set up system security page, click **New User** on the action bar. The New User screen appears.

2. In the **User name** field, enter the name the user will use to log into the program.

3. In the **Description** field, enter a full name or other information to identify the user.

4. In the **Connection Options** frame, mark **Use FE7 Authentication** if you want a user’s log in information for The Financial Edge to be separate from his or her workstation log in information.
5. If you mark **Use FE7 Authentication**, enter the user’s password in the **Password** field. Enter the password again in the **Confirm** field.

6. Mark **Use Windows Authentication** if you want a user’s log in information for The Financial Edge to be based on his or her Windows log in information. When users logged into a workstation through their Windows authentication access The Financial Edge, the Windows information is used to automatically log the user into the program.

To associate a user’s Windows authentication information with The Financial Edge, use the **Login** field to locate that user’s account on your network.

   a. Click the binoculars in the **Login** field. The Select User Account screen appears.

   b. In the **List Names From** field, select the system to which the user you want to select belongs.

   c. All members of the selected system appear in the **Names** box. Select the user you want to specify and click **Add**. The name appears in the **Add Name** field.

   d. Click **OK**. You return to the Security User screen where the user now appears in the **Login** field.

7. In the **User Type** field, select “User can only access The Financial Edge”, “User can only access online modules”, or “User can access The Financial Edge and online modules”.

8. In the **Groups for <Your Organization>** frame, to assign the user full access to the programs, mark **Supervisor rights**. To restrict access to certain security groups, mark **Selected group rights**.

9. If you mark **Selected group rights**, select the user’s group from the **Not a member of** box and click the single right arrow to move the group to the **Member of** box.

10. To grant the user the right to change his password, mark **User can change password**. For more information about changing passwords, see “Passwords” on page 147.

11. To grant the user the right to change his options, mark **User can change User Options**. To set options, click **Set this user’s options** after saving the user to open the user’s options screen. At the bottom of the Options screen, you can click **Copy From** to copy another user’s options. Using this feature helps keep data consistent.
12. If you have the optional module *Advanced Security*, select the Account Security tab.

13. In the **Account access** field, select the access level you want the user to have. If you select “Allow access to selected Accounts” or “Prevent access to selected Accounts”, mark **Query**, **Range**, or **Selected**.

   - If you mark **Query**, enter a query name in the **Query Name** field or click the binoculars to locate the query.

   - If you mark **Range**, in the **Start Account Number** column, enter a starting account number. In the **End Account Number** column, enter an ending account number. The account descriptions appear from the account records.

   - If you mark **Selected**, enter an account number in the **Account Number** column. Repeat for each account the user will be able to access.

14. If you have the optional modules *Advanced Security* and *Projects and Grants*, select the Project Security tab to define additional security for projects.

15. In the **Project access** field, select the projects you want the user to be able to access. If you select “Allow access to selected Projects” or “Prevent access to selected Projects”, mark **Query**, **Range**, or **Selected**.

   - If you mark **Query**, in the **Query Name** field, enter a query name or click the binoculars to locate the query.
If you mark **Range**, enter a starting project number in the **Start Project Number** column or click the binoculars to locate a number. In the **End Project Number** column, enter an ending project number or click the binoculars to locate a number. The project descriptions appear from the project records.

If you mark **Selected**, enter a project number in the **Project Number** column. Repeat for each project the user will access.

16. If you have the optional module *Advanced Security* and the program *Accounts Payable* or *Payroll*, select the Signature Security tab.

17. Mark the **Choices?** checkbox to make a signature available for use.
18. If you have the optional modules *WebPurchasing* or *WebInvoicing*, select the Online Security tab.

19. In the **Online Systems** box, mark **WebPurchasing** to set user security for your *WebPurchasing* users.

20. In the **Department** field, select the user’s department. If the department is not listed, you can click **Department** to access the Department table and add a new entry, or edit existing table entries.

21. To allow the user to approve or reject requisitions, mark **Can approve Requisitions**. Marking this option allows the user to be added to *WebPurchasing* approval rules.

22. To allow the user to approve his own requisitions, mark the **Can self-approve Requisitions**.

   To restrict the amount a user can self-approve, enter the maximum amount in the **Requisition self approval limit** field.

23. In the **Create Receipts** frame, select one of the following options:
   - Cannot create Receipts
   - Can create Receipts for own Requisitions
   - Can create Receipts for all Requisitions

24. To allow the user to view all requisitions, mark **Can view all Requisitions**.

25. To allow the user to edit other users’ information on the My Account page, mark **Can edit My Account information for other users**.
26. If you have the optional module *WebInvoicing*, mark the **Web Invoicing** checkbox.

27. Mark the **Can approve Invoice Requests** checkbox to allow the user to approve invoice requests. Marking this option allows the user to be added to *WebInvoicing* approval rules.

28. Mark the **Can self-approve Invoice Requests** checkbox to allow the user to self-approve invoice requests.

   To restrict the amount a user can self-approve, enter the maximum amount in the **Invoice Request self approval limit** field.

   Invoice requests under self-approve limits are automatically approved up to the self-approval limit.

29. To allow the user to view invoice requests created by all *WebInvoicing* users, mark **Can view all Invoice Requests**.

30. To allow the user to change their GL distribution on the My Account page in *WebInvoicing*, mark **Can change GL distribution in My Account**.

31. To allow the user to edit other user’s information on the My Account page in *WebInvoicing*, mark **Can edit My Account information for other users**.

---

If the approver has an account restriction in *Security*, he will not be able to approve an invoice request for a category that contains that restricted number. Be sure to review their account security restrictions after establishing the account numbers in their Expense Categories.
Invoice requests under self-approve limits are automatically approved up to the self-approval limit.

32. If you have the optional module *Advanced Security* and the program *Payroll*, select the Employee Security tab.

33. In the **Employee access** field, select the employees you want the user to be able to access. If you select “Allow access to selected Employees” or “Prevent access to selected Employees”, mark **Query**, **Range**, or **Selected**.

   If you mark **Query**, in the **Query Name** field, enter a query name or click the binoculars to locate the query.

   If you mark **Range**, enter a starting employee in the **From Employee** column or click the binoculars to locate an employee. In the **To Employee** column, enter an ending employee or click the binoculars to locate an employee. The employee IDs appear from the employee records.

   If you mark **Selected**, enter an employee in the **Employee Name** column. Repeat for each employee the user will access.

34. To save the user security settings and return to the Set up system security page, click **Save and Close**.
Editing the security rights of a user

You can change the security rights of a user by changing the security groups to which the user belongs. You can add or remove a member from a group either directly from the user’s record or through the group record.

1. From the Set up system security page, select a user and click Open on the action bar. The User screen for the selected user appears.

2. To change the user’s group, select a group to change and use the arrows to move groups between the Not a member of and Member of boxes.

3. To save the changes and return to the Set up system security page, click Save and Close.
Printing a security user profile report

You can print a security profile of the user before you delete the user name from security.

1. From the Set up system security page, select a user and click **Open**. The User screen for the selected user appears.

2. To preview the report, select **File**, **Print Preview**.

3. To print the report, select **File**, **Print**.

4. To return to the Set up system security page, select **File**, **Close**.

Deleting a user

You can delete a user from a security group when a user’s responsibilities change or a user leaves your organization. The user can no longer log into the system when deleted from security. However, the individual’s history of activity in the program with his user name attached is not removed from the database.

However, before deleting a user, you should log in as the user and check the settings and rights:

- If a user has action reminders scheduled and is deleted, the reminders remain active but never occur. You should consider reassigning the action reminders to another user.

- The user may have created queries and exports that are restricted to other users. Open each of the user’s queries, select **Tools**, **Query Options**, and mark the checkboxes for other users to run and modify the query. Open each of the user’s exports, select **Tools**, **Export Options**, and mark the checkbox for other users to run and modify the export.
The user may have restricted reports and mailings from other users. Open each of the user’s reports and mailings, select **File, Save As**, and mark the checkboxes for other users to run and modify the report or mailing.

**Deleting a user from Security**

1. From the Set up system security page, select the user to delete from the tree view.
2. On the action bar, click **Delete**. The record opens and a message appears asking if you want to change the user name and save the record before deleting it.
3. To delete the user, click **No**.
   To close the message and edit the record, click **Yes**.

**Advanced Security**

With the optional module **Advanced Security**, you can grant users view-only access to the database and you have additional security options on user records.

**View-Only Users**

View-only user licenses are an optional feature with **Advanced Security**. This license allows users to view data, without having rights to edit or enter it, and to create and modify report and queries. Users have full rights to **Dashboard, Plug-Ins, Reports** and **Query** and limited access to **Records, Banks, Visual Chart Organizer** and **Journal Entry**. The view-only user is not permitted in **Administration and Configuration**.

To create a view-only user, mark **User can view data but cannot make changes**, which appears on the User Information tab.

A view-only user can be restricted by group rights. If you add a view-only user to a group with rights to **Accounts Payable** only, he will be restricted from viewing data in other programs. Adding a view-only user to a group with add, edit, or delete rights to records will not increase the user’s rights.
# Plug-Ins

Contents

<table>
<thead>
<tr>
<th>Task</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Update Accounts</td>
<td>174</td>
</tr>
<tr>
<td>Initialize Accounts Receivable and Cash Receipts Systems</td>
<td>174</td>
</tr>
<tr>
<td>View Locked Records/Processes</td>
<td>175</td>
</tr>
<tr>
<td>Convert Billing Years</td>
<td>175</td>
</tr>
<tr>
<td>Link to Other Blackbaud Systems</td>
<td>177</td>
</tr>
<tr>
<td>View Database Connections</td>
<td>178</td>
</tr>
<tr>
<td>Patron Edge Import Utility</td>
<td>179</td>
</tr>
<tr>
<td>Update Cached Record Balances</td>
<td>180</td>
</tr>
<tr>
<td>View Product Details</td>
<td>180</td>
</tr>
<tr>
<td>Import ADP Payroll Transactions</td>
<td>181</td>
</tr>
<tr>
<td>Update the Payers and Statements Tab on Student Records</td>
<td>182</td>
</tr>
<tr>
<td>Convert Your Student Billing 6.4 Data</td>
<td>183</td>
</tr>
<tr>
<td>Update the Effective Dates for Payroll Compensation Types</td>
<td>184</td>
</tr>
<tr>
<td>Reset the Registry</td>
<td>184</td>
</tr>
</tbody>
</table>
Plug-ins are specially built applet extensions of *The Financial Edge*. A Plug-in ‘plugs in’ to *The Financial Edge*, opening the door to a wide range of custom functionality. Plug-Ins can be as simple as an HTML page or a Microsoft Office document or as complicated as a multi-level ActiveX document or interactive spreadsheet. This flexible technology makes adding custom applications and extensions directly to *The Financial Edge* easy. Plug-Ins share the database connection and runtime code resources with *The Financial Edge*, making them an excellent choice for adding custom functionality without an extensive API application.

**Update Accounts**

The Update Accounts plug-in synchronizes *Accounting for Nonprofits* version 6.4 modules to recognize new accounts and/or projects that are entered in *General Ledger 7*. Before converting, we recommend that you run the Update Accounts plug-in available on the Plug-Ins page.

- **Update Accounting for Nonprofits modules with General Ledger 7 projects and accounts**
  1. From the navigation bar, select *Plug-Ins*. The Plug-Ins page appears.
  2. From the Plug-Ins page, click *Update Accounts*. The Update Accounts page appears.
  3. To synchronize any changes to your General Ledger 7 accounts or projects with your existing 6.x applications, mark **Update Accounts** and/or **Update Projects**.
  4. To run this utility, click **Update**.
  5. When your accounts and projects are updated, click **Back** to return to the Plug-Ins page.

**Initialize Accounts Receivable and Cash Receipts Systems**

After upgrading to *The Financial Edge*, run the Initialize Accounts Receivable and Cash Receipts Systems plug-in to convert your data from *Accounts Receivable 6.x* or *Miscellaneous Cash Receipts 6.x* to version 7.

For more information, see the *Conversion Planning Guide* and *Conversion Guide* for *The Financial Edge*.
View Locked Records/Processes

The Locked Record Viewer shows you database connections and record locks. You can access the Locked Record Viewer from the Plug-Ins page of any program.

- View locked records/processes
  1. From the Plug-Ins page, click Locked Record Viewer. The Locked Record Viewer screen appears.

  ![Locked Record Viewer screenshot]

  2. To return to the Plug-Ins page, click Back.

Convert Billing Years

The Convert Billing Years plug-in converts billing cycles from Student Billing 6.x to Student Billing 7. The converted billing cycles contain the same functionality as the original billing cycle. Once the plug-in is run, you can not run it again.

- Convert billing cycles
  1. From the navigation bar, select Plug-Ins. The Plug-Ins page appears.
2. From the Plug-Ins page, click **Convert Billing Years Utility**. The Convert Billing Years utility screen appears.

3. In the **School to use** field, select a school that contains **Student Billing 6.x**. This field determines what schools billing cycles are copied from **Student Billing 6.x** to **Student Billing 7**.

4. In the billing cycles grid, mark the **Create?** checkbox to select the billing cycles for conversion.
5. In the **Product and Billing Items** grid, mark the **Update?** checkbox next to the specific product and billing items you want to update.

6. To convert the selected billing cycles and update the selected product or billing items, click **Update**.

7. To return to the Plug-Ins page, click **Back**.

**Link to Other Blackbaud Systems**

We have included a plug-in you can use to create links, which are like shortcuts, to other programs. For example, you can create a link to **Payroll** so you no longer need to access the program menu in **Windows** to access **Payroll**. Once the links are established, you can quickly access the program from the navigation bar.

To create favorites to other programs, click **Create Links to Blackbaud Systems** on the Plug-Ins page. Once created, the links are housed in the Blackbaud Systems group on the navigation bar.

- **Create links to other Blackbaud systems**
  1. From the navigation bar, select **Plug-Ins**. The Plug-Ins page appears.
  2. From the Plug-Ins page, click **Create Links to Blackbaud Systems**. The Create Links to Blackbaud Systems screen appears.
3. By default, each system installed on your computer appears next to a marked checkbox. If you do not want to create a link for a specific system, remove the corresponding check mark.

4. To add a Blackbaud system to the navigation bar, click **Create Links**.

5. When you click **Blackbaud Systems** in the navigation bar, a list of links to the other systems appears. Click a link to display the program components in the shell.

![Image of Blackbaud Student Billing window]

### View Database Connections

The Database Connection Viewer shows you which users are connected to the database. You can access the Database Connection Viewer from the Plug-Ins page of any program.

> **View database connections**

1. From the Plug-Ins page, click **Database Connection Viewer**. The Database Connection Viewer screen appears.

![Image of Database Connection Viewer]

2. To return to the Plug-Ins page, click **Back**.
Patron Edge Import Utility

Once you run the Post to GL wizard in The Patron Edge and create an export file of transaction information to post to General Ledger, you can access The Financial Edge and import the transaction information.

When you import the transactions, you create a journal entry batch to be posted. Typically, the export file created in The Patron Edge by the box office staff is forwarded to the business office to be imported into The Financial Edge.

For more information about integrating with The Patron Edge, see the The Patron Edge and The Financial Edge Integration Guide.

➢ Import Patron Edge Transactions

To import transaction information, the export file generated from The Patron Edge must be accessible.

1. From The Financial Edge, click Plug-Ins on the navigation bar. The Plug-Ins page appears.

2. Click Patron Edge Import Utility.

3. In the Import File field, click the browse button and select the *.csv file of transaction data generated from The Patron Edge.

4. In the Exception File field, an output location and name for the file is automatically displayed. By default, the file is saved in the same location as the import file and “exception” is added to the filename. To change the default, click the browse button and enter a name and output location for the*.csv exception file.

5. In the Batch Description field, enter a description to identify the batch of transactions that will appear in Journal Entry as a result of the import. A default description is provided with the date and a “Patron Edge” designation.

6. When you are ready to import the transactions and create a batch in Journal Entry, click Create Batch. Once processing is complete, you can access the Journal Entry page in General Ledger to view and post the new batch of transactions. For information about posting, see the The Patron Edge and The Financial Edge Integration Guide. If exceptions are found, review the exception file and makes changes as needed.
Update Cached Record Balances

You can run the **Update Cached Record Balances** plug-in to calculate the current account balances in the **Balance** and **Balance with scheduled activity** fields that appear in the status bar of student, individual, and organization records. If you do not run this plug-in, **Student Billing** automatically calculates the balances when the student, individual, or organization record is opened for the first time after upgrading, which can slow the data entry process.

We recommend that you start the plug-in on a separate machine that can run uninterrupted because you will not be able to navigate away from the plug-in once it starts running.

1. From the Plug-ins page, click **Update Cached Record Balances**. The **Update Cached Record Balances** page appears.
2. Mark **Run plugin**.
3. Click **Update**. The **Update Cached Record Balances** screen appears displaying the progress of the calculations.
4. When finished, a completion screen appears displaying the number of records processed. Click **OK** to exit and return to the Plug-Ins page.

View Product Details

Using the **Product Details** plug-in, you can generate a text file that includes information about your product installation. For example, you can use this plug-in to find the number of user licenses your organization owns.

1. On the Plug-Ins page, click **Miscellaneous**, and then **Product Details**. The **Product Details** page appears.
2. Click **Create**. A text file appears displaying the server name, server properties, organization name, country, serial number, database, number of users, and the programs and modules installed.

   The text file is saved automatically to the root of your hard drive (for example, C:\BBDetails7.txt).

3. When you close the text file, you return to the Product Details page.

---

**Import ADP Payroll Transactions**

If you do not have Blackbaud’s *Payroll* program installed, you can use the ADP Import Utility to import your ADP payroll transactions into *The Financial Edge*.

Once you receive the export file of the payroll transaction information you want to post to *General Ledger*, you can access The Financial Edge ADP Import Utility from the *Financial Edge* Plug-ins page and import the transaction information. When you import the transactions, you create a journal entry batch to be posted.

- **Importing ADP payroll transactions into The Financial Edge**

  1. From *The Financial Edge*, access the navigation bar and click **Plug-Ins**. The Plug-Ins page appears.

  2. Click **The Financial Edge ADP Import Utility**.

  3. In the **Import File** field, click the browse button and select the .csv file of payroll transaction data you want to import.

  4. In the **Exception File** field, an output location and name for the file is automatically displayed. By default, the file is saved in the same location as the import file and “exception” is added to the file name. To change the default, click the browse button and enter a name and output location for the .csv exception file.

  5. In the **Batch Description** field, enter a description to identify the batch of transactions that will appear in *Journal Entry* as a result of the import. A default description is provided with the date.

  6. In the **Journal** field, select the type of batch you want to create.

  7. If necessary, you can click **Clear** to clear all fields.
8. When you are ready to import the transactions and create a batch in *Journal Entry*, click **Create Batch**. Once processing is complete, you can access the Journal Entry page in *General Ledger* to view and post the new batch of transactions. If exceptions are found, review the exception file and make changes as needed. This may require sending the file back to ADP.

### Update the Payers and Statements Tab on Student Records

Using the Statements and Payers utility in *Student Billing*, you can refresh your database to clean up Statement and Payers tab issues. You select the query of student records to update, whether to clear the current settings on the Payer or Statement tabs, and which relationships should be payers.

- **Update the Payers and Statements tab on student records**
  
  1. From the Plug-ins page in *Student Billing*, click **Miscellaneous**, then **Statements and Payers Utility**. The Statements and Payers Utility page appears.

  ![Statements and Payers Utility](image)

  2. In the **Query** field, select the query of student records whose Statements and Payers tab you want to update.

  3. In the Update section, you have two options.

    - Mark **Payers tab for students marked to assign each charge to a payer's account** to update the Payers tab for records included in the query.
- Mark **Statements tab** to update the Statements tab for records included in the query.

4. If you marked **Payers tab for students marked to assign each charge to a payer's account** the **Clear existing entries on the payers tab** option is enabled. Mark this option to clear anything that currently is on the Payers tab for the records in the query.

5. In the **Mark the following relationships as payers** box, mark each relationship type you want to make payers for the student.

    If the student record has multiple relationships specified in the **Mark the following relationships as payers** box, all that meet the criteria are added to the student’s Payers tab and the payment responsibility is divided among all the relations. For example, you mark **Mother** and **Father**. A student’s mother and father are both added as payers with 50% payment responsibility.

    If a student has more than one relation of a selected type, the first entry on the Relationships tab is made a payer. For example, if you have two records whose relationship is “Mother” to the child, the first record listed in the grid is made the payer on the Payers tab.

    If the student has “Assign each charge to this student’s account” selected in the **Billing option** field on the Bio 1 tab, this update will not change his Payers tab.

6. If you marked **Statements tab**, the **Clear existing entries on the statements tab** option is enabled. Mark this option to clear anything that currently is on the Statements tab for the records in the query.

7. In the **Mark these relationships as statement recipients** box, mark each relationship type you want to make statement recipients for the student.

8. Mark **Run plugin** and click **Update**. The process runs and then a completion screen appears. Click **OK** to return to the Miscellaneous page.

---

**Convert Your Student Billing 6.4 Data**

The conversion of your **Student Billing 6.4** data does NOT occur automatically. You must manually install the conversion utility and convert your data after updating or installing the latest version of **The Financial Edge** or **The Education Edge**. Before attempting to run the conversion, make sure you have reviewed the pre-conversion considerations and followed any recommendations that apply to your organization.

For more information, see the **Conversion Planning Guide** and **Conversion Guide** for **The Financial Edge**.
Update the Effective Dates for Payroll Compensation Types

The Payroll - Compensation type date utility updates the setting in the Effective date field for employee compensation types (pay types, deductions, or benefits) whose start and end dates conflict with the actual calculation dates.

➤ Update the effective dates for compensation types
1. From the Plug-ins page, click Miscellaneous, then Payroll - Compensation type date utility. The Payroll - Compensation type date utility page appears.
2. Mark Analyze compensation type effective dates to create a list of compensation types with invalid effective dates.
3. Mark Repair compensation type effective dates to update the effective dates for the compensation types with conflicts.
4. Click Update.
5. Once the processing completes, a list of changes appears on the page.

Reset the Registry

The Reset Registry plug-in resets user preferences to the default installation settings. The registry reset applies to only the workstation the plug-in is run on.

Changing registry settings incorrectly can cause serious problems that may be irreversible without reinstalling the program. You must back up your database before making any registry changes. Blackbaud is not responsible for damage resulting from incorrect use of the Reset Registry plug-in.

➤ Reset the registry
1. From the Plug-ins page, click Miscellaneous, then Reset Registry. The Reset Registry page appears.

We strongly recommend that you make a backup of your database before resetting the registry. For information about creating a backup, see the Database Administration Guide.
2. To reset all options in the database, mark **Current Database**.

3. To reset only specific options, mark the checkbox next to the items to reset.

4. Click **Delete**.

5. Click **Yes** on the confirmation screen that appears. The items you marked to reset are removed from the list.

6. To view the changes to the database, select **Exit and Sign Out** and then re-open the program.
Index

A
accessing
   Administration 3
   security
Accounts Payable
   posting 5
   setting up 4
Accounts Receivable
   posting 5
   setting up 4
accruing attendance expenses 116
add operation 130
adding
   electronic signatures 14
   security groups 150
   user passwords 148
   users to security groups 162
Administration
   accessing 3
   overview 3
ADP
   import payroll transactions 181
Advanced Security 171
   view-only users 171
application
   updating 58, 59
asset
   inventory
      overview 49
      report 49
      scanning barcodes 49
      purging 47
   attendance, accruing expenses 116

B
bank account, encrypting numbers 160
barcodes, scanning for asset inventories 49
batch
   posting
      from Accounts Payable 5
      from Accounts Receivable 5
      from Cash Receipts 5
      from Fixed Assets 5
      from General Ledger 17
      from subsidiary ledgers 18
   validation
      requirements 16
beginning balance
   entering 27, 28
   locking 32
      overview 31
      overview 27
   billing cycle
      convert 175

C
Cash Receipts
   posting 5
   setting up 4
client, merging duplicates 42
closing fiscal years 23
consolidation export files, creating 13
Consolidation Management, creating export files for
   convert
      billing cycles 175
   copy operation 132
   copying
      user options 163
   creating, see adding
   credit card, encrypting numbers 160
database connection viewer 178
database, validating 12
delete operation 131
deleting
   security groups 155
   users 171
duplicate records
   merging client records 42
   merging vendor records 41
   searching for 10
edit change parameters screen 129
editing
   security group information 153
   supervisor password 146
   user security rights 169
   electronic signature, adding 14
   encrypting personal information 160
   entering beginning balances 27
fiscal year
   closing 23
   pre-closing 23
   purging 26
summarizing 25  

**Fixed Assets**  
posting 5  
setting up 4  
formatting  
asset inventory reports 49  
fund transaction requirements, updating 34  

**G**  

**General Ledger**  
posting  
  batches 17  
  subsidiary ledgers 18  
setting up 4  
validating batches 17  
global change  
  filters tab 127  
  general tab 123, 125  
  globally changing records 132  
operations 129  
  add 130, 138  
  copy 132  
  delete 131  
  increase/decrease 131  
  move 132  
  partial replace 131  
  replace 131  
  swap 132  
globally adding to records 138  
globally changing records, overview 9  
group profile report 155  
group security  
  adding groups 150  
  deleting groups 155  
  editing group information 153  
  overview 149  
  printing group profile reports 155  

**M**  
marking students for reenrollment 63  
mid-quarter convention, switching to 48  
modifying, see editing  
move operation 132  

**N**  
numbers, encrypting 160  

**O**  
opening, see accessing  
operation, global change 129  
options  
  copying 163  

**P**  
partial replace operation 131, 133  
password  
  adding 148  
  changing supervisor 146  
  overview 147  
Patron Edge  
  import transactions 179  
payroll  
  import ADP transactions 181  
**Payroll**, accruing attendance expenses 116  
plug-in  
  create links to other Blackbaud systems 177  
  update accounts 174  
  update cached record balances 180  
  update the Payers and Statements tab on student records 182  
posting  
**Accounting For Nonprofits 6.4**  
  subsidiary ledgers 18  
**Accounts Payable** 5  
**Accounts Receivable** 5  
**Cash Receipts** 5  
**Fixed Assets** 5  
  overview 16  
regular batches in **General Ledger** 17  
pre-closing fiscal years 23  
printing  
  asset inventory reports 49  
  group profile reports 155  
  user profile reports 170  
process, locked 175  
product installation details 180  
purging  
  assets 47  
  fiscal years 26  

**L**  
locked process 175  
locked record 175  
locking beginning balances 32  
  overview 31
vendor activity 36, 37
vendors 36, 39

R
record
globally adding to 138
globally changing 9, 132
importing 9
locked 175
partially replacing 133
searching for duplicates 10
reenrolling students, marking with the status wizard 63
registry, reset 184
replace operation 131
report
asset inventory 49
group profile 155
user profile 170
reset registry 184

S
scanning barcodes for inventories 49
searching for duplicate records 10
security
accessing 144
Advanced Security 171
copying user options 163
encrypting personal information 160
passwords 147
settings 11
shared components 158
supervisor procedures 145
view-only users 171
security group
adding groups 150
deleting groups 155
editing group information 153
overview 149
printing group profile reports 155
security user
adding users to groups 162
overview 162
setting up
Accounts Payable 4
Accounts Receivable 4
Cash Receipts 4
Fixed Assets 4
General Ledger 4
shared components, security 158
signature, adding electronically 14
Social Security number
encrypting 160
status wizard
mark for reenrollment 62
update applications 58
updating applications 59
student
reenrolling with status wizard 62
subsidiary ledger, posting 5, 18
summarizing fiscal years 25
supervisor procedures
assigning supervisor rights 146
changing supervisor passwords 146
overview 145
swap operation 132
switching to mid-quarter convention 48
system statistics, viewing 4
update
effective dates for compensation types
plug-in
update effective dates for compensation types 184
Payers and Statements tab 182
update applications wizard 58
update cached record balances 180
updating
accounts and projects 174
update applications 59
updating fund transaction requirements 34
user licenses, viewing 180
user profile report 170
user security
adding users to groups 162
advanced options 171
Advanced Security 171
deleting users from Security 171
editing security rights 169
overview 162
printing user profile reports 170
view-only 171
validating 16
batches
balancing requirements 16
in General Ledger 17
databases 12
vendor
merging duplicates 41
purging 39
vendor activity, purging 37
viewing
database connections 178
locked processes 175
locked records 175
product details 180
viewing system statistics 4
view-only users 171

W
Windows authentication 162